
 

 

 

 

 

 

 

 

Stellar Toolkit for Outlook 

User Guide for Version 12.0.0.2 



Overview 

 
Stellar Toolkit for Outlook is the collection of following softwares: 

 
1. Stellar Repair for Outlook ï Technician 

2. Stellar Converter for OST ï Technician 

3. Stellar Merge Mailbox for Outlook ïTechnician 

4. Stellar Undelete Email for Outlook 

5. Stellar Splitter for Outlook 

6. Stellar Compactor for Outlook 

7. Stellar Password Recovery for Outlook 



System Requirements 

 
Before installing the software, ensure that your system meets the minimum system requirements. 

 
Minimum System Requirements: 

 

¶ Processor: Intel-compatible (x86, x64) 

¶ Operating System: Windows 11 / Windows 10 / Windows 8.1 / Windows 8 / Windows 7 

¶ Memory: 8 GB (recommended) 4 GB (minimum) 

¶ Hard Disk: 250 MB for installation files 

¶ MS Outlook: Office 365 / 2021 / 2019 / 2016 / 2013 / 2010 / 2007 

 
Note: MS Outlook version depends on the respective software of Stellar Toolkit for Outlook 

that you are using. 

 
Note: For large files, it is recommended to have 64-bit  Windows, 64-bit  MS Outlook and 8 GB 

RAM. 



Installation Procedure 
 

To install the software, follow these steps: 

 
1. Double-click StellarToolkitforOutlook.exe setup installer to start the installation. Select 

Setup Language dialog box appears. 

2. From the drop-down list, select your language and click OK. Setup - Stellar Toolkit for 
Outlook 

window appears. 

3. Click Next. License Agreement dialog box appears. 

4. Choose I accept the agreement option. Next button will be enabled. Click Next. 

Select Destination Location dialog box appears. 

5. Click Browse to select the destination path where the setup files are stored. Click Next. 

Select Start Menu Folder dialog box appears. 

6. Click Browse to provide a path for the program's shortcuts. Click Next. Select 

Additional Tasks dialog box appears. 

7. Select checkboxes as per your choice. Click Next. Ready to Install dialog box appears. 

8. Review your selections. Click Back if you want to change them. Click Install to start 

the installation. The Installing window shows the installation process. 

9. On completion of the installation process, Completing the Stellar Toolkit for Outlook 

Setup Wizard window appears. Click Finish. 

Note: Clear Launch Stellar Toolkit for Outlook check box to prevent the software from launching 

automatically. 

Note: If you have Stellar Toolkit for Outlook application installed in your system and you have 

to reinstall MS Outlook/Office for any reason, in that case you need to reinstall the Stellar 

Toolkit for Outlook as well. 



User Interface 

 
After launching the software, the main user interface appears as shown below: 

 



Ordering the Software 

 
To know more about Stellar Toolkit for Outlook, visit 

https://www.stellarinfo.com/email- tools/outlook-toolkit.php 

 
To purchase the software online, please visit https://www.stellarinfo.com/email- 

tools/outlook- toolkit/buy-now.php 

 
Alternatively, click on Buy Online icon in menu bar to purchase the software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, you will receive an activation key through email. You require this 

key to activate the software. 

https://www.stellarinfo.com/email-tools/outlook-toolkit.php
https://www.stellarinfo.com/email-tools/outlook-toolkit.php
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php


Activating the Software 

 
The demo version is just for evaluation purpose and must be eventually activated to use the full 

functionality of the software. An 'Activation Key' is required to activate your copy of the software 

and save data. You will receive an activation key through email after purchasing the software. 

Note: Make sure that you have an active Internet connection. 

 
Steps to activate the software: 

 
1. Run Stellar Toolkit for Outlook. 

 
2. Click the Activation button on the Buy Now ribbon. A window, as displayed below, pops 

up on the screen. 

Note: 

 
¶ If you don't have the activation key, click Get it now button in the window to go 

online and purchase the product. 

¶ Once the order is confirmed, an Activation Key is provided. 

 
3. Enter the Activation Key and click Activate button. 

 

 
4. The software is activated after successful verification of the activation key you have 

entered. 

5. 'Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK to use all the options of the software that have been unlocked after the 

activation. 



Updating the Software 

 
Stellar releases updates for Stellar Toolkit for Outlook. You can update the software to keep it up- 

to-date. These updates can add new functionality, feature, service, or any other information that can 

improve the working of the software. The update option of the software is capable of checking for the 

latest updates. This will check for both latest, minor and major versions available online. While 

updating the software, it is recommended to close all the running programs. 

 
To update Stellar Toolkit for Outlook: 

 
Automatic Update: 

 
1. Run Stellar Toolkit for Outlook. 

2. If an update is available, Update Wizard window appears along with the main 

user interface. 

3. Click Next to start downloading the update files from the server. After the completion of 

the process, the software is updated to the latest version. 

4. Click Finish to close the Update Wizard. 

 
Manual Update: 

 
1. Run Stellar Toolkit for Outlook. 

2. Select Update from Tools ribbon. Update Wizard window pops up. 

3. The wizard will start searching for the latest updates: 

i. If the new version is found a window will pop up indicating the availability of an update. 

ii. If no update is available then it indicates that the software is up-to-date. 

4. If the update is available, click Next and the software will start downloading and 

installing update files from the server. 

5. When the process is completed, the software is updated to the latest version. Click Finish. 

 
Note: To disable automatic update when you launch the Stellar Toolkit for Outlook 

uncheck the checkbox 'Check updates at startup'. 

 
Live Update may not happen due to following reasons: 

¶ Internet connection failure. 

¶ Updates are not available. 

¶ Unable to download configuration files 



¶ Unable to locate updated files or version 

¶ Unable to locate executable file 



Stellar Support 

 
Our Technical Support professionals will give solutions for all your queries related to Stellar 

products. 

 

¶ You can either call us or go online to our support section at http://stellarinfo.com/support/ 

¶ For price details and to place the order, click 

https://www.stellarinfo.com/email- tools/outlook-toolkit/buy-now.php 

¶ Chat Live with an Online technician at http://stellarinfo.com/support/ 

¶ Search in our extensive Knowledgebase at 

https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager 

¶ Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

¶ Send e-mail to Stellar Support at support@stellarinfo.com 

http://stellarinfo.com/support/
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php
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Stellar Repair for Outlook ï Technician 

 
User Guide 12.0 



1. About Stellar Repair for Outlook - Technician 

 
Stellar Repair for Outlook offers a complete solution to repair damaged Microsoft Outlook Personal 

Storage (.pst) files and Offline Outlook Data (.ost) files. 

 
The software repairs corrupt PST/OST files and restore all its content such as E-Mails, Attachments, 

Contacts, Calendars, Tasks, and Journals. Also, it repairs accidentally deleted or lost Mailbox items. 

This minimizes the loss from the PST/OST corruption. Stellar Repair for Outlook scans and extracts 

data from a damaged PST/OST file, repairs it, and then saves it as a new usable PST file. To view 

repaired items, you need to import the new PST file into MS Outlook. 

 
Stellar Repair for Outlook also recovers accidentally deleted e-mails that you have emptied from the 

deleted items folder. After recovering the PST/OST file, the software shows its original content. All 

folders from the original PST/OST file display along with their content in a three-pane structure. 

 
Key features: 

 

¶ Supported Output Formats - Repairs and exports OST/PST files to Microsoft 365, Existing 

Outlook Profile, Live Exchange Server or save in PST, MSG, EML, RTF, PDF, HTML, and 

MBOX format. 

¶ Encrypted Files Support - Supports repair of encrypted Outlook data files. 

¶ Recover Deleted Items - Supports recovery of deleted items. The software also provides a 

preview of the deleted items marked with red color. 

¶ Auto split PST file - Option to auto split new PST file at approximately 45 GB in size. 

¶ Apply Advance Filter - Option to filter specific and particular mailboxes from repaired file. 

¶ Preview Option - Provides preview of mails and items such as - Attachments, Calendars, 

Contacts, Tasks, Notes, and Journals. 

¶ Compress and Split PST files - Option to compress or split the files and save them in PST 

file format. 

¶ Quick Save Option - Right-click and save individual e-mails in MSG, EML, RTF, HTML, and 

PDF from the preview section. 

¶ Selective Repair - Provides the option to only save selected mailbox folders as per 

requirement. 

¶ Find Option - Provides search option to find e-mails faster. 

¶ Resume Function - Option to save scanned information to resume the process at a later 

stage. 

¶ Source Outlook Data File Support - Repairs corrupt MS Outlook 2021, 2019, 2016, 2013, 

2010 and 2007 data files (OST and PST). 



¶ MS Office Support - Supports Microsoft 365 2021, 2019, 2016, 2013, 2010 and 2007. 
 

¶ Operating System - Compatible with Windows 11, Windows 10, Windows 8.1, Windows 8 

and Windows 7 (x64 edition only). 



2. User Interface 

 
Stellar Repair for Outlook has a simple and easy-to-use Graphical User Interface (GUI). The GUI of 

the software resembles the GUI of MS Office 2016. 

 
After launching the software, the main user interface appears as shown below: 

 

The user interface contains Ribbons and Buttons, Preview Tabs that allow you access various 

features of the software with ease. 



2.1 Ribbons and Buttons 

 
1. File Menu 

 

The File ribbon contains the following buttons : 

 
¶ Select Outlook Data File: Use this option to select/search for PST and OST files. 

¶ Save Repaired File: Use this option to save the repaired file at your specified location. 

¶ Exit: Use this option to close the software. 
 

 
2. Home Ribbon 

 

The Home ribbon contains the following buttons:  

 
¶ Select Outlook Data File: Use this option to select/search for PST and OST files. 

¶ Save Repaired File: Use this option to save the repaired file at your specified location. 

¶ Find Message: Use this option to search for specific emails and messages from the list 

of scanned emails. 

¶ Save Scan: Use this option to save the scanned information of files. 

¶ Load Scan: Use this option to load the saved scan file. 
 

 
3. View Ribbon 

 

The View ribbon contains the following buttons:  
 

¶ Switch Reading Pane: Use this option to switch between horizontal and vertical views of 



the reading pane. 

¶ Log Report: Use this option to view the log report. 
 

 

4. Tools Ribbon 

 

The Tools ribbon contains the following buttons:  

 
¶ Save All Contacts as CSV: Use this button to save all recovered contacts as a CSV file. 

¶ Relink Attachments: Use this button to relink the attachment folder 

¶ Update Wizard: Use this option to update your software. 
 

 
5. Calendar Ribbon 

 

The Calendar ribbon contains the following buttons:  

 

¶ Day: Use this option to list all the entries of a particular day from the calendar. 

¶ Work Week: Use this option to list all the entries of a work week (from Monday to Friday). 

¶ Week: Use this option to list all the entries of a week (from Monday to Sunday). 

¶ Month: Use this option to list all the entries of a particular month. 

¶ GoTo: Use this option to list all the entries of the current date or any particular date. 
 

 
6. Activation Ribbon 

 

The Activation ribbon contains the following buttons:  

 

¶ Activation: Use this option to activate the software after purchasing the software. 



7. Help Ribbon 
 

The Help ribbon contains the following buttons:  

 

¶ Help Topics: Use this option to open the help manual of the software. 

¶ Knowledgebase: Use this option to visit the Knowledgebase articles of stellarinfo.com. 

¶ Support: Use this option to visit the support page of stellarinfo.com. 

¶ About: Use this option to read information about the software. 
 
 
 

 
8. Buy Now Ribbon 

 

The Buy Now ribbon contains the following buttons:  

 

¶ Buy Online: Use this option to buy Stellar Toolkit for Outlook. 
 
 

 
9. Language Menu 

 

¶ Language: Use this option to change the language of the application. In the drop- down 

menu you will find the following language options: English, French, German, Italian, 

Spanish and Japanese. 

 
 

 
10. Style Menu 

http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php


 

¶ Style: Use this option to switch between various themes for the software, as per 

your choice. Stellar Repair for Outlook - Technician offers the following themes: 

Office 2016 Colorful Theme, Office 2016 White Theme. 



2.2. Preview Tabs 

Stellar Repair for Outlook provides options to navigate between Mails, Calendar, Contacts, Tasks, 

Journal and Notes views at the bottom of the left pane. It also allows to reset/modify the Navigation 

Pane Options. 

 

¶ Click on Mail  icon to view the mails of the scanned mailbox. 
 

¶ Click on Calendar icon to view the Calendar functions scanned mailbox. It displays the 
schedules in an organized and efficient manner. 

 

Calendar function also allows to efficiently display the schedule for a day, work week, week, or 

month. 



 

 

 

 
Click this button to list all the entries of one particular day from the calendar. 

 

 

 

 
Click this button to list all the entries of a work week (from Monday to Friday). 

 

 

 

 
Click this button to list all the entries of a week (from Monday to Sunday). 

 

 

 

 
Click this button to list all the entries of a particular month. 

 

 

 

 
Click this button to list all the entries of the current date, or of a particular day (any 

single day except the current date). 

 

 

¶ Click on Contacts  icon to view the contacts of the scanned mailbox. 
 



¶ Click on Tasks icon to view the tasks of the scanned mailbox. 
 

¶ Click on Journal icon to view the created journal entries of the scanned mailbox. 
 



¶ Click on Notes icon to view the notes of the scanned mailbox. 
 

¶ Click on and select Navigation Pane Options. This will open the Navigation 
Pane Options window. 

 

 
To modify/reset the navigation pane options: 

 

¶ Check/ uncheck the preview tab that you want to add/ remove from the list. 

¶ Click Move Up/ Move Down button to modify the order of the preview tabs. Move Up 

button will shift the desired tab upwards and Move Down button will shift the desired tab 

downwards in the list. 

¶ Click Reset to go back to the default list of preview tabs. 

¶ Click OK to save the changes. 



3. Working with the Software 

 
3.1. Select and Repair File 

3.2. Preview Repaired File 

3.3. Find, View and Save a Single Message 

3.4. Save Repaired File 

3.5. Save all Contacts as CSV 

 
3.6. Relink Attachment Folder 

3.7. Save Log Report 

3.8. Save and Load Scan Information 

3.9. How to Apply Advance Filter 

 
3.10. Importing PST file in Microsoft Outlook 

 
3.11. Changing the Software Language 



3.1. Select and Repair File 

If you know the location of the PST or OST file, then you can directly specify the location and start 

repairing e-mails of that file. If you do not know the location, then you can search the required PST or 

OST file by using the search functionality of Stellar Repair for Outlook. 

 
It is advised to disable your antivirus software before scanning because, in some instances, there 

is a possibility that the mailbox you are attempting to repair contains virus-infected attachments. Thus, 

your vigilant antivirus software will take immediate action to protect your system by flagging and moving 

the potential threat to quarantine, due to which you will not be able to retrieve those files entirely, 

as shown while scanning. 

Steps to select and repair PST file: 

 
1. Run Stellar Repair for Outlook. 

 

2. . Select Outlook Data File for Repair window appears when the software launches. 

Alternatively, you can also open Select Outlook Data File for Repair window from File menu or 

Home ribbon 

 
 

3. There are two tabs available to select the PST or OST files: Choose Mailbox Manually and 
Profile List. 

 
(i) Choose Mailbox Manually: This is the default selected tab. Use this tab when the file location is 

known. 

There are two options to select PST or OST files: Browse and Find. 

 
(i) Browse: Use Browse button if you are aware OST or PST file location. 

 
a) Click on Browse button, locate PST or OST file and then click Open. 

 
b) Click Repair to start the repairing process. 



 

 
c) After the process is completed a Repair Complete dialog box appears with a 

message, "Selected file repaired". 

d) Click OK. 

 
(ii) Find: Use Find button to search for OST or PST files on your system's drives, folders, and 

subfolders. 

 

 
a) Click Find, Find Outlook Mailbox window appears. 

b) Select the drive from the drop-down list. However, you can only select one drive 

at a time. 

c) Click Find button to start the search process. 

d) If you wish to stop the search process, click Stop. 



e) After the search is finished, Find Complete dialog box appears with the 

number of files found. Click OK. 

f) The list of files found in the selected drive is displayed in the Results section. 

Select the file you want to repair, only one file can be selected at a time. 

 
Note: If you want to clear the search result, click Clear List. 

 
g) Click Repair button to start the repairing process. 

h) After the process is completed a Repair Complete dialog box appears with a 

message, "Selected file repaired". 

i) Click OK. 
 
 
 

 
(iii) Profile List: Use this tab to list all the configured outlook profiles from your system. 

 
a) Click this tab, List configured profiles dialog box is displayed. 

 
Note: Only once you need to list configured profiles. 

 

 
b) Click List Profiles button to list all the outlook profiles from your system. Total 

number of listed profiles are displayed. 



 

 
c) From the list, select the required outlook profile. 

d) Click Repair to start the repairing process. 

e) After the process is completed a Repair Complete dialog box appears with a 

message, "Selected file has been repaired". 

 

 
f) Click OK to complete the process. 

 
Note: To save repaired file, click Save Repaired File button. 

 
After the repair process is completed, the software provides a preview of the repaired files. 

See Preview Repaired Files. 



3.2. Preview Repaired File 

 
Stellar Repair for Outlook shows the preview once the PST/OST file is repaired. The preview 

of the mailbox data is available in a three- p a n e  structure containing: Left pane, Middle pane 

and Right pane, which are explained below with details: 

 

¶ The left pane provides the navigation tree, displaying the files with its mailboxes, 

folders and sub-folders. Select the desired mailbox/folder/sub-folder from this pane. 

¶ The middle pane provides a list of mailbox items, in a tabular format, of the 

selected mailbox/folder/sub-folder. The pane contains the following columns: 

o Deleted icon: It shows the deleted mails of the selected mailbox, in red color. 

o Importance icon: It signifies that the particular mail is sent with high importance. 

o Type: It shows the type of mail item it has. 

o Attachments: Shows an attachment icon if the particular mail item contains 

an attachment. 

o From: Shows the e-mail address of the sender. 

o To: Shows the e-mail address of the receiver. 

o Subject: Shows the e-mail subject. 

o Date: Shows the date and time when the e-mail was sent. 

Tip: You can change the order of the above given columns as per your requirement. Click and 

hold on the column name and drag the column to the desired location to change it. 

¶ The right pane provides the preview of the mail item that you select from the middle 

pane. It shows the following information: 

o Subject: Shows the subject of the e-mail. 



o From: Shows the e-mail address of the sender. 

o To: Shows the e-mail address of the receiver. 

o Attachments: Shows the attachments of the selected mailbox item. 

o Body: Shows the preview of body of the selected mail item. 

Note: To switch between vertical and horizontal reading panes, click Switch Reading Pane icon 

in View ribbon. 

 

Additional Options: 

 
¶ Quick search: The software provides quick search options for Mails. In the middle pane 

below the table headings, type the keywords in the search bar of a particular column. The 

columns that support quick search are From, To, Subject, and Date. 
 

¶ Sorting columns: You can sort the mails and media items using the table headers in the 

middle pane. Click on the column heading to sort the column in ascending order. Click on 

the same heading again to change the sorting order from ascending to descending and 

vice versa. 
 

 
Alternatively, you can right click on the column and arrange it accordingly by using Arrange 

By option. It can be arranged by Date, From, To, Subject, Type, Attachment, Deleted, 

Importance or Show in Groups option. 



3.3. Find, View and Save a Single Message 

 
Stellar Repair for Outlook - Technician allows you to find and repair a particular message from 

the PST file. The software offers a Find Message feature, which helps you narrow the search 

using various search options. You can save a message directly from the search result inMSG, EML, 

RTF, HTML, PDF format. 

 
To find messages: 

 
1. Click Find Message in Home ribbon. Find Message window opens. 

 
2. Specify the search criteria in Find Message window: 

 
¶ In To field, specify all or few characters of email ids of recipients. Keywords should 

get separated by a semicolon (;). 

¶ In From field, specify all or few characters of email ids of senders. Keywords should 

get separated by a semicolon (;). 

¶ In Subject field, specify the subject that you need to search. 

¶ If you want to search for emails sent or received on a particular date, select Select 

Date Field checkbox, and select date from Date drop box. 

3. Click Find Now button to start the search. 

 

 

To view messages: 

 
1. After the search is completed, a list of emails that match the search criteria gets displayed. 

2. Double-click on an email to open it in a new window. 



To save messages: 

 
To save any message from the search result list, right-click on it and: 

¶ Select Save as MSG to save the message in MSG format. 

¶ Select Save as EML to save the message in EML format. 

¶ Select Save as RTF to save the message in RTF format. 

¶ Select Save as HTML to save the message in HTML format. 

¶ Select Save as PDF to save the message in PDF format. 



3.4. Save Repaired File 

This section explains how to save repaired outlook data file in PST or other formats. This section also 

describes how to export repaired data file into Existing Outlook Profile, Microsoft 365, and Live 

Exchange Server. Before saving or exporting a repaired file, read this section carefully. 

Note: Before you start the saving process of repaired files make sure that Microsoft Outlook is closed. 

 
Once selected outlook data file has been repaired, click Save Repaired File from Home ribbon. Save 

As window appears with following options. Choose any one of the options as per your requirement. 

3.4.1. Save as PST Format 

3.4.2. Export to Existing Outlook Profile 

3.4.3. Export to Microsoft365 

3.4.4. Export to Live Exchange Server 

3.4.5. Save as Other Formats 

 
Note: If you have repaired default OST file using Profile List option and want to save repaired file in 

this case also Save As options will appear same as listed above. 

 
The Save As options will differ only If you have repaired default PST file using Profile List option and 

want to save repaired file. In this case, either you can save repaired PST file as a default Mailbox 

Configuration or you can Browse and click OK to save repaired file at specific destination. 

 
Steps to save repaired default PST file: 

 
1. Run Stellar Stellar Repair for Outlook 

2. See Select and Repair File, to know how to select and repair corrupted outlook data files. 

3. Click Save Repaired File from Home ribbon to save repaired PST file. 

4. Select Destination screen appears. Click Browse to save repaired PST file at specified 

destination. 

 



Note: 

 
¶ Recover Deleted Items check box is selected by default, uncheck it if deleted repair items 

are not required. 

¶ Click Apply Advance Filter if you want to apply filter on the repaired files. 

 
5. Click OK 

6. After the saving process is completed, Saving Complete dialog box appears with the message 

"PST mailbox repaired and configured in your Outlook successfully". It shows the path 

and size of the repaired file. 

 

 
7. Click OK to complete the process. 

 
Note: If you save repaired PST file as a default destination, the data file will be saved and 

configured with the same mailbox attributes. 

 
Note: To view the recovered Outlook data, open the repaired file in Microsoft Outlook. You will find 

the recovered data under the "Top of Outlook data file" folder in the same Mailbox attributes as 

before. 



3.4.1. Save as PST Format 

 
Stellar Repair for Outlook provides a feature to save repaired files in either normal, compact or 

split PST files. Refer to the following topics as per your requirements: 

 
 3.4.1.1. Save as PST Normally 
 
 3.4.1.2. Compact and Save PST File 
 
 3.4.1.3. Split and Save PST File 



3.4.1.1. Save as PST Normally 

 
Stellar Repair for Outlook allows you to save the repaired mails to a new PST file. The software 

provides options to compress, split and filter files before saving. 

 
Note: Before you start the saving process of repaired files make sure that Microsoft Outlook is closed. 

 
Steps to save as PST format: 

 
1. Run Stellar Repair for Outlook. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 
 

4. Choose Save As PST and click Next. 

 
5. Save As PST window appears, Choose Save PST Normally option and click Next. 

 

6. Select Destination screen appears, click Browse to save repaired PST file at specified 

destination. 



 

 
Note: 

 
¶ Recover Deleted Items check box is selected by default, uncheck it if deleted repair items are 

not required. 

¶ Auto split PST file check box is selected by default, uncheck it if you do not want to split 

repaired PST file. This option helps to auto split new PST file at approximately 45 GB in size. 

¶ Click Apply Advance Filter if you want to apply filter on the repaired files. 

 
7. Click OK. 

 
8. After the saving process is completed, Saving Complete dialog box appears. It shows the path 

and size of the repaired file. 

 

 
9. Click 'How to import PST file?' to know how to import the new PST file in MS Outlook. 

 
10. Click OK to complete the process. 



3.4.1.2. Compact and Save PST File 

 
Stellar Repair for Outlook compact and save PST file feature compresses the PST file and decrease 

the size acquired by them in the disk. This enhances the greater use of memory and also saves 

PST file from being corrupted. 

There are four options to compact and save PST file. Refer to the following options as per 

requirement: 

1. Compress all attachments in new PST 

2. Extract and save attachments to a folder (No interlinking is lost) 

3. Remove all attachments to new PST 



3.4.1.2.1. Compress all attachments in new PST 

 
You can use this option to compress all the attachments of the emails in the new repaired PST 

file. The compressed attachments remain in the repaired files. 

Note: Before you start the saving process of repaired files make sure that Microsoft Outlook is 

closed. 

 
Here are the steps to compress all attachments in a new PST file: 

 
1. Run Stellar Repair for Outlook. 

 
2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

 
3. Click Save Repaired File from Home ribbon to open a Save As window. 

 

4. Select Save As PST and click Next. 

 
5. Save as PST window appears, choose Compact and Save PST and click Next. 

 

 
6. Compact PST window appears, choose Compress all attachments in new 

PST option and click Next. 



 

 
7. Select Destination screen appears, click Browse to save repaired PST file at specified 

destination. 

 

 
Note: 

 
¶ Recover Deleted Items check box is selected by default, uncheck it if deleted 

repair items are not required. 

¶ Auto split PST file check box is selected by default, uncheck it if you do not want to 

split repaired PST file. This option helps to auto split new PST file at approximately 45 

GB in size. 

¶ Click Apply Advance Filter if you want to apply filter on the repaired files. 

 

8. Click OK to start the saving process. 

9. After the saving process is completed, Saving Complete dialog box appears. It shows the 

path and size of the repaired file. 
 

10. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

https://www.stellarinfo.com/help/preview/stellar-repair-for-outlook-12-windows-technician-en-how-to-apply-advance-filter.html


11. Click OK to complete the process. 



3.4.1.2.2. Extract and save attachments to a folder (No 

interlinking is lost) 

You can use this option to extract attachments from the PST file and then save them in a new folder 

in their original form. A shortcut to the extracted attachments remains in the repaired PST file. 

This option will extract attachments to a new folder without making any changes to the content 

or the attachments of the original PST file. 

 
Note: Before you start the saving process of repaired files make sure that Microsoft Outlook is closed. 

 
Steps to extract and save attachments of a PST file to a folder (No interlinking is lost): 

 
1. Run Stellar Repair for Outlook - Technician. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 
 

4. Select Save as PST and click Next. 

 
5. Save as PST window appears. Choose Compact and Save PST and click Next. 

 

 
6. Compact PST window opens, choose Extract and save attachments to a folder (No 

interlinking is lost) option and click Next. 



 

Note: If you want to know how to relink attachments, click 'How to relink attachment folder?' 

 
7. Select Destination screen appears, click Browse to save repaired PST file at specified 

destination. 

 

 
Note: 

 
¶ Recover Deleted Items check box is selected by default, uncheck it if deleted 

repair items are not required. 

¶ Auto split PST file check box is selected by default, uncheck it if you do not want to split 

repaired PST file. This option helps to auto split new PST file at approximately 45 GB in 

size. 

¶ Click Apply Advance Filter if you want to apply filter on the repaired files. 

 
8. Click OK to start the saving process. 

9. After the saving process is completed, Saving Complete dialog box appears. It shows the path 

and size of the repaired file. 
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10. Click 'How to import PST file?' to know how to import the PST file in MS Outlook. 

11. Click OK to complete the process. 



3.4.1.2.3. Remove all attachments in new PST 

 
You can use this option to remove all the attachments in the repaired PST fil. This option 

retains only the mail and deletes all its attachments. No changes are made to the original file. 

 
Note: Before you start the saving process of repaired files make sure that Microsoft Outlook is 

closed. 

Steps to remove all attachments in new PST: 

 
1. Run Stellar Repair for Outlook. 

2. See Select and Repair File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 
 

4. Select Save as PST and click Next. 

 
5. Save as PST window appears. Choose Compact and Save PST and click Next. 

 

6. Compact PST window opens, choose Remove all attachments in new PST option 

and click Next. 



 
 

7. Select Destination screen appears, click Browse to save repaired PST file at specified 

destination. 

 

 
Note: 

 
¶ Recover Deleted Items check box is selected by default, uncheck it if deleted 

repair items are not required. 

¶ Auto split PST file check box is selected by default, uncheck it if you do not want to split 

repaired PST file. This option helps to auto split new PST file at approximately 45 GB in 

size. 

¶ Click Apply Advance Filter if you want to apply filter on the repaired files. 

 
8. Click OK to start the saving process. 

9. After the saving process is completed, Saving Complete dialog box appears. It shows the path 

and size of the repaired file. 

 

 
10. Click 'How to import PST file?' to know how to import the PST file in MS Outlook. 
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11. Click OK to complete the process. 



3.4.1.3. Split and Save PST File 

Stellar Repair for Outlook allows you to split PST files into different sizes. You can split a PST file 

into various sizes up to the maximum size of 50GB. 

 
For large files, Stellar Repair for Outlook automatically splits the new PST file into small sizes. The 

size of the split files will depend on the version of Outlook installed on your computer: 

 
a. If you have Outlook 2007 installed, the new PST will split at approximately 18 GB size. 

b. If you have Outlook 2010 or above installed, the new PST will split at approximately 45 

GB in size. 

 
Note: 

 
¶ Before you start the saving process of repaired files make sure that Microsoft Outlook is closed. 

¶ You can use Split and Save PST option when repaired mailbox size is more than 1GB. 
 

 
Steps to Split and Save PST file by size: 

1. Run Stellar Repair for Outlook. 

2. See Select and Repair File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 
 

4. Select Save as PST and click Next. 

 
5. Save as PST window appears. Choose Split and Save PST option and click Next. 



 
 

6. Split PST screen appears. In Select size box, type or select the size as per your 

requirement and split the repaired mailbox. 

Note: You can split repaired mailboxes into many parts to the maximum size of 50 GB. 

 

7. Click Next. Select Destination screen appears. 

 

 
8. Click Browse to save repaired PST file at specified destination. 

 
Note: 

 
¶ Recover Deleted Items check box is selected by default, uncheck it if deleted 

repair items are not required. 

¶ Auto split PST file check box is selected by default, uncheck it if you do not want to split 

repaired PST file. This option helps to auto split new PST file at approximately 45 GB in 

size. 



¶ Click Apply Advance Filter if you want to apply filter on the repaired files. 

 
9. Click OK. 

10. After the saving process is completed, Saving Complete dialog box appears. It shows the path 

and size of the repaired file. 

 

 
11. Click 'How to import PST file?' to know how to import the PST file in MS Outlook. 

12. Click OK to complete the process. 

https://www.stellarinfo.com/help/preview/stellar-repair-for-outlook-12-windows-technician-en-how-to-apply-advance-filter.html


3.4.2. Export to Existing Outlook Profile 

Stellar Repair for Outlook provides a feature to export PST files to the existing outlook profile. 

 
Note: Before you start to export existing outlook profiles make sure that Microsoft Outlook is closed. 

 

 
Here are the steps to export PST file to Existing Outlook profile: 

 
1. Run Stellar Repair for Outlook. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 
 

4. Choose Export to Existing Outlook Profiles and click Next. 

 
5. Select Outlook Profile window is displayed. Select an Outlook profile from the list of 

MS Outlook profiles shown. 

 
Note: If the Outlook profile is password protected, Enter Password window will appear. Enter 

the password and click OK. 

 
Note: If you don't have any outlook profile, by default an outlook profile will be generated and 

repaired mailboxes will be saved in the default location. 



 

 
Note: 

 
¶ Recover Deleted Items check box is selected by default, uncheck it if deleted 

repair items are not required. 

¶ Click Apply Advance Filter if you want to apply filter on the repaired files. 

 
6. Click OK to start saving process. 

7. After the saving process is completed, Saving Complete dialog box appears. It shows the path 

and size of the repaired file. 

 

 
8. Click OK to complete the process. 

https://www.stellarinfo.com/help/preview/stellar-repair-for-outlook-12-windows-technician-en-how-to-apply-advance-filter.html


3.4.3. Export to Microsoft 365 

Stellar Repair for Outlook provides a feature to export the repaired mailbox to your Microsoft 365 

accounts. 

 
Note: 

 
¶ To use Export to Microsoft 365 option, make sure that you have an active internet connection. 

¶ Before you start the saving process of repaired files make sure that Microsoft Outlook is 

closed. 

¶ Before saving the converted mailbox to Microsoft 365, make sure that Microsoft 365 account is 

configured in MS Outlook application. 

¶ Online mailbox data cannot get exported to Microsoft 365. You can only export your offline 

mailbox data to Microsoft 365. 

 
Steps to export required mailbox to Microsoft 365: 

 
1. Run Stellar Repair for Outlook. 

 
2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

 
3. Click Save Repaired File from Home ribbon to open a Save As window. 

 

4. Select Export to Microsoft 365 and click Next. 

5. Microsoft 365 Login Details window appears. Select only Microsoft 365 profile name from 

the dropdown list. 



 

 
Note: 

 
¶ Recover Deleted Items check box is selected by default, uncheck it if deleted 

repair items are not required. 

¶ Click Apply Advance Filter if you want to apply filter on the repaired files. 

 
6. Click OK to start the saving process. 

7. After the saving process is completed, Data Export Successful dialog box appears with 

message "Data successfully exported to Microsoft 365". 

 

 
8. Click OK to complete the process. 
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3.4.4. Export to Live Exchange Server 

Stellar Repair for Outlook provides a feature to connect exchange server through Admin or User 

credentials and export the repaired mailbox to a live MS Exchange Server. 

 
Steps to export the repaired mailbox to live MS Exchange Server: 

 
1. Run Stellar Repair for Outlook. 

2. See Select and Repair File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open Save As window. 

 

 
4. Select Export to Live Exchange Server option from Save As window and click Next. 

Exchange Server Details window appears. 

 

 
5. There are two options: 

 
(a) Login with Administrator account of Domain: Use this option when you have 

administrator credential details. 

 
(i) Choose Login with Administrator account of Domain radio button. 

 
(ii) Enter Exchange Server Name in the text field. 



Note: Exchange 2010 and Higher check box is by default selected, unselect it if not 

required. 

 
(iii) Click Next. 

 
(iv) Enter Details dialog box appears. 

 

(v) Under Exchange Admin Details section enter Admin Email ID, Admin Name, 

and Admin Password. 

 
(vi) Under Destination Mailbox Details section enter Mailbox Email ID. 

 
Note: Recover Deleted Items check box is by default selected, unselect it if not required. 

 
Note: Refer to section Apply Advance Filter, to know how to apply filter. 

 
(vii) Click OK to connect to your mailbox. 

 
(b) Login with Domain User Account: Use this option when you have user account credential 

details to connect live exchange server. 

 
(i) Choose Login with Domain User Account radio button. 

 
(ii) Enter Exchange Server Name in the text field. 

 
Note: Exchange 2010 and Higher check box is by default selected, unselect it if not 

required. This software will not support Exchange server below 2010. 

 
(iii) Click Next. 

 
(iv) Enter Exchange Mailbox Details dialog box appears. 



 

(v) Enter Mailbox Email ID, Mailbox Name, and Mailbox Password. 

 
Note: 

 
¶ Recover Deleted Items check box is by default selected, unselect it if not required. 

¶ Refer to section Apply Advance Filter, to know how to apply filter. 

 
(vi) Click OK to connect to your exchange server mailbox. 

 
(vii) Saving process starts, if you want to stop the process click Stop button. 

 
(viii) After successful saving process, saving complete dialog box appears with message, 

"Selected message saved successfully". 

 
(ix) Click OK to complete the process. 



3.4.5. Save as Other Formats 

 
Stellar Repair for Outlook saves the repaired file in MSG, EML, RTF, PDF, HTML or MBOX formats. With 

the Naming Convention option, the mail items can be saved with specific names such as Subject of the 

e-mail, Date of the e-mail, and Sender of the e-mail. 

Note: Before you start the saving process of repaired files make sure that Microsoft Outlook is closed. 

 

Steps to save the repaired file: 

 
1. Run Stellar Repair for Outlook. 

2. See Select and Repair File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open Save As window. 

4. From Save As window, select Other Formats option. Drop-down list box enables. 

 

 
5. Select any one of the formats (MSG, EML, RTF, PDF, HTML or MBOX) from the item list and 

click Next. 

6. Naming Convention window appears, select anyone from the following options: 

 
o Subject - The repaired file will be saved with the name as the respective email message's 

subject. 

o Subject + Date (DD-MM-YYYY) - The repaired file will get saved with the name as 

the respective email message's subject, and date. 

o Date (YYYY-MM-DD) + Subject - The repaired file will get saved with the name as the 

respective email message's date, and subject. 

o From + Subject + Date (YYYY-MM-DD) - The repaired file will get saved with the name 

as the respective email message's sender, subject, and date. 

o Date (DD-MM-YYYY) + From + Subject - The repaired file will get saved with the name 

as the respective email message's date, sender, and subject. 



o Date (YYYY-MM-DD) + From + Subject - The repaired file will get saved with the name 

as the respective email message's date, sender and, subject. 

o Date (MM-DD-YYYY) + Subject + From - The repaired file will get saved with the name 

as the respective email message's date, subject, and sender. 

 

 
7. Click Next. 

8. Select Destination screen appears. Click Browse to save repaired file at specified destination. 

 

 
Note: 

 
¶ Recover Deleted Items check box is selected by default, uncheck it if recover deleted items 

are not required. 

¶ Auto split PST file check box is selected by default, uncheck it if you do not want to split 

repaired PST file. This option helps to auto split new PST file at approximately 45 GB in size. 

¶ Click Apply Advance Filter if you want to apply filter on the repaired files. 

 
9. Click OK. A window appears and shows the status of Saving in progress. 

10. After successful saving completion, a Saving Complete dialog box appears with a message, 

"Selected messages saved successfully". 

11. Click on 'Open containing folder' link to view the saved messages. 
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3.5. Save All Contacts as CSV 

Stellar Repair for Outlook provides feature to save all contacts as a CSV file. 

 
Steps to save all contacts as a CSV file: 

 
1. From Tools ribbon, select Save All Contacts as a CSV. 

2. Select Destination screen appears. Click Browse to save all contacts as a CSV file at specified 

destination. 

 

 
Note: Recover Deleted Contacts check box is selected by default, uncheck it if recover deleted 

contacts are not required. 

 
3. Click OK to complete the process. 



3.6 Relink Attachment Folder 

You need to relink the attachment folder when you move it after using Extract and save attachments 

to a folder (No interlinking is lost) option. 

 
To do this: 

 
1. Click Relink Attachments from Tools ribbon. 

 

2. Click on Select PST and Select Folder button to browse and select the repaired PST file, and its 

attachment folder. 

 
3. Click on Relink button to relink the attachments to the emails. 

 
Note: You can move the attachments folder to a different location on the same local machine, or 

you can move both the repaired PST file and the attachments folder to another machine. 



3.7 Save Log Report 

 
With Stellar Repair for Outlook, you can save the Log Report to analyze the repairing 

process at a later stage. 

 
Here are the steps to save log report: 

 
1. From View ribbon, select Log Report. 

2. In Log Report window, click Save Log. 
 

3. In Save As window, specify the location where you want to save the log file. Click Save. 



3.8 Save and Load Scan Information 

 
This option allows you to save the scanned information of files using "Save Scan Info" option 

and later load the saved scan (.DAT) file using "Load Scan Info" option. This saves time in 

restoring data as we do not need to scan the corrupt PST / OST file again. 

 
Steps to save scan information from the corrupt file: 

 
1. From the Home ribbon, select Save Scan Info. 

 

2. Save Scan Information window will open. Browse to the folder where you want to save 

the scan information and click OK. The information will get saved in .DAT file format. 

3. A message box appears, click OK. 
 

 
Load Scan Information 

This option is used to start repairing procedure from saved scan information or.DAT file. 

Here are the steps to load scan information of the corrupt PST file: 

1. To load the scan information, click on Load Scan Info option from the Home ribbon. 
 

2. Load Scan window will appear. It displays a list of saved scan information file existing in 

the system. 



3. In case the file you desire is not in the list, click Add button and select the desired DAT file. 

4. Click Open. 

 
5. The file you added is displayed in the load scan window. Click Remove button if you 

want to remove the save scan (.DAT) file. 

6. Click Reset button to reset the load scanned list. 

7. Click Load Scan button. 

8. A message box appears, click OK. 
 

Note: You can select only one file at a time to start the process of scanning. 



3.9. How to Apply Advance Filter 

Stellar Repair for Outlook provides an advanced filtering feature to find specific and particular 

mailboxes using Date Range filter. You can also narrow your search results by excluding specific 

sendersô IDs from all the repaired mailboxes. 

 
Steps to apply advanced filter: 

 
1. In Apply Filter window, under Include section there are two check boxes: 

 

 
a) Include 'Junk Email' folder: Select this check box to include junk email files and 

folders. 

b) Include 'Delete Items' folder: Select this check box to include deleted items file 

and folder. 

 
2. From Date Range section select the specific Start Date and End Date to find the specific 

mailboxes. 

3. From Sender IDs to be excluded section enter the list of specific sendersô ID's that you don't 

want to include. 

 
a. In Add to List text field enter specific sender ID's that you don't want to include. 

 
Note: You can include only one sender ID at a time in Add to List text field. 

 
b. Then click Add to List button to list it. 

c. All the check boxes are selected by default, deselect the unrequired check boxes. 



4. Click Apply button to apply the filters. 



3.10. Importing PST file in Microsoft Outlook 

 
To import PST file in Microsoft Outlook 2019 / 2016 / 2013: 

 
1. Open Microsoft Outlook. From File Menu, select Open & Export. 

 
2. Select Import / Export option from the right pane. 

 
3. From Import and Export Wizard window, select Import from another program or file, click 

Next. 

 
4. In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 
5. Click Browse to locate the PST file that needs to get imported. In the options box, 

select an appropriate option. Click Next. 

6. In Import Outlook Data File dialog box, select the folders that should get 

imported in Microsoft Outlook. Click Finish. 

 
 

 
To import PST file in Microsoft Outlook 2010: 

 
1. Open Microsoft Outlook. From the File Menu, select Open -> Import. 

 
2. From Import and Export Wizard window, select Import from another program or file, click 

Next. 

 
3. In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 
4. Click Browse to locate the PST file that needs to get imported. In the options box, 

select an appropriate option. Click Next. 

5. In Import Outlook Data File dialog box, select the folders that should get 

imported in Microsoft Outlook. Click Finish. 

 
 

 
To import PST file in Microsoft Outlook 2007:  

 
1. Open Microsoft Outlook. From the File menu, select Import and Export. 

 
2. From Import and Export Wizard window, select Import from another program or file, click 

Next. 



3. In Import a File dialog box, select Personal Folder File (PST), click Next. 

 
4. Click Browse to locate the PST file that needs to get imported. In the options box, 

select an appropriate option. Click Next. 

5. In Import Personal Folders dialog box, select the folders that should get 

imported in Microsoft Outlook. Click Finish. 



3.11. Changing the Software Language 

 
In order to use Stellar Repair for Outlook software in your preferred language, the 

application provides an option to select any of the desired language. Using the Languages 

button, you can change the entire application to a different language at any time/instance 

without having to re-install the application. 

 
Steps to change language of the application: 

 
1. Run Stellar Repair for Outlook. 

 
2. Click Language button located at the top right corner. 

 
3. A dropdown list appears with the following languages: 

 

¶ English 

¶ French 

¶ German 

¶ Italian 

¶ Spanish 

¶ Japanese 

 
4. Select the desired language. The application language will be changed accordingly. 



4. Frequently Asked Questions (FAQs) 

1. What does Stellar Repair for Outlook do? 

 
The software repairs the corrupted PST and OST files and restores all their data such as E-Mails, 

Attachments, Contacts, Calendars, Notes, Tasks and Journals. Stellar Repair for 

Outlook provides the preview of all scanned data and provides options to save them 

in PST, MSG, EML, RTF, HTML and PDF format. 

 
2. I have forgotten the path of my file. Can this software search it for me? 

 
Yes, the software can look for PST/OST files on your system and find them for you easily. There 

is a dedicated Find option in the software through which you can locate a particular file and run a 

repair on it. 

 
3. I had run the demo and can see the preview correctly in the software window. Do I need to 

rescan the corrupted file? 

 

No, in the Demo version you can preview repaired files only after scanning. This special feature is 

included in the software to make sure that you can first preview the repair results on the damaged 

PST/OST file and only after you are satisfied with the results, you should decide to purchase and 

save your repaired files. 

 
4. I want to recover permanently deleted emails from my Outlook. Will Stellar Repair for 

Outlook help? 

 
Yes, the software scans and recovers the permanently deleted emails from Outlook. You can also 

preview the deleted items before saving them. These deleted items will be shown in red color at 

the time of preview. 

5. Can we exclude the deleted items from the recovered mailbox while saving? 

 
Yes, select the checkbox "Do not Recover Deleted Items" to exclude the deleted items from the 

repaired file. 

 
6. How much time will the software take to repair a PST/OST file? 

 
The scanning time depends upon the corruption level, size of the file, and also the number of 

mailbox items in the mailbox. If the process is running, that means that software is still scanning 

the corrupted file and you have to wait for this scanning process to complete. After scanning 

is completed, you will be able to save the repaired file at the desired location. 

 
7. I got the error "Invalid Outlook Data File" while scanning. What could be the reason? 

 

There could be the following reasons for this error message: 



¶ The Outlook Data File is severely corrupted or is not in a repairable state. 

¶ The Outlook Data File is not valid. 

¶ The file could not be accessed. 

 
8. I have repaired my corrupt file. But Iôm unable to find my contacts. How can I find them? 

 
Easily locate and access your contacts with the given steps: 

 
¶ Import your repaired file into MS Outlook. 

¶ Open MS Outlook. 

¶ Then press "Ctrl+Shift+F". 

¶ "Find Message / Advanced Find" window will open. Please select "Contacts" under 

"Look For" tab. 

¶ Click on the "Browse" button and select the imported file. 

¶ Then, click "Find Now." 

¶ Now you can see all the contacts that you were able to preview with the softwareôs Demo 

Version. You may select the entire contacts listed and drag it to your original contacts list, 

so that you may use it further. 

 
9. Can I repair a corrupt file of size more than 2 GB? 

 
Absolutely yes, this software is capable of repairing files that are more than 2 GB. Please 

download the demo version and scan your PST/OST file. You can also preview all e-mails and 

other mailbox items that you recovered with this software. 

 
10. I want to analyze the repair process. Can I see the log report at a later stage? 

 
Certainly. The software provides an option to save and view log reports at any point in time. To 

view and save log reports follow the given steps: 

 
¶ On View ribbon, select 'Log Report.' 

¶ In Stellar Repair for Outlook window, click 'Save Log' and save it at the desired location 

to view it at any time. To know more refer to Log Report. 

 
11. Should Microsoft Outlook be installed in my system while I repair my file and it works well 

with which version? 

 
Microsoft Outlook is not required while repairing and previewing PST/OST files. It must be 

installed in your system to use the saving options. The software is compatible with the following 

versions: 

Microsoft Outlook: Microsoft 365 2021 / 2019 / 2016 / 2013 / 2010 / 2007. 

 
12. What does the compact feature of Stellar Repair for Outlook do? 



As the name suggests, the compact feature of Stellar Repair for Outlook helps in reducing the size 

of PST files and attachments on the MS Exchange Server. It has various options for attachments of 

emails that can get selected for compaction and extraction. 

13. Why do I need to compact PST files? 

 

MS Outlook stores all data like e-mails, personal data, calendar, tasks, etc. in a PST file. Eventually, 

the file becomes oversized. Such PST files are prone to corruption, so you need to compact them. 

Stellar Repair for Outlook has a compaction feature using which you can compact the PST file. 

 

14. Can I extract all my attachments in a separate folder while compacting the PST file? 

 
Yes, you can extract the attachments in a separate folder. To do this, choose the Extract attachments 

and leave shortcuts in emails in Compacting Option before starting the compact process. The 

attachments are left as shortcut links in the e-mails. 

 
15. Can I restore the links to attachments to the PST file? 

 

Yes, you can restore the links by using the Relink Attachment Folder. You need to relink the attachment 

folder when you move it after using Extract and save attachments to a folder (No interlinking is lost) 

option. 

 
16. I want to run the software on select folders of the PST file. Can I choose some selected 

mailbox folders in the software? 

 
Yes, you can apply extraction and compaction settings on only the selected folders of the PST file. 

 
17. I repaired my Outlook Data File, but Iôm unable to open my Outlook after repair. How can I 

solve this problem? 

 
If this happens, follow the steps below to resolve the problem: 

 
¶ Open Windows -> Control Panel. 

¶ Double-click Mail. In Mail Setup window, select E-mail Accounts to configure your email 

account. 

¶ After configuring, close the window and open MS Outlook. 

¶ To view the repaired PST file, you can either select Open -> Outlook Data File from File 

ribbon or, Import the PST file in MS Outlook. 

 
18. In how many ways can I split a PST file using Stellar Repair for Outlook? 

 
There are two ways in which you can split a PST file using Stellar Repair for Outlook software. Refer 

to the following ways as per your requirements: 



a) Auto Split PST files: For large repaired files use this option to split files into small size. The 

size of split files will depend on the version of outlook installed in your computer. 

i. If you have Outlook 2007 installed, the new PST will split at approximately 18 

GB size. 

ii. If you have Outlook 2010 or above installed, the new PST will split at 

approximately 45 GB to 48 GB in size. 

b) Split and Save PST: This is a manual option to split repaired file into various size up to the 

maximum size of 50GB. You can use this option when repaired mailbox size is more than 1 GB. 

To know more refer to Split and Save PST File. 

 
19. I have a PST file exceeding 50 GB in size, does the new PST file generated will have the 

same size as that of the source PST file? 

 
For large files, Stellar Repair for Outlook automatically splits the new PST file into small sizes. The 

size of the split files will depend on the version of Outlook installed on your computer: If you 

have Outlook 2007 installed, the new PST will be split at approximately 18 GB size. If you 

have Outlook 2010 or above installed, the new PST will be split at approximately 45 GB to 48 GB 

in size. 

20. After saving my repaired mailbox in PST format. How to view and access the mailbox 

items? 

 
After you saved the repaired mailbox in PST format, you can import the PST file in MS Outlook. 

See Importing PST file in MS Outlook, to know how to import PST file. 

 
21. Why am I not able to retrieve the entire mailbox as displayed while scanning? 

 
There is a possibility that the mailbox you are attempting to repair contains virus-infected 

attachments. If your antivirus software is working, it will take immediate action to protect your 

system by flagging and moving the potential threat to quarantine, due to which you will not be able 

to retrieve those files entirely, as shown while scanning. Therefore, it is advised to disable your 

antivirus software before scanning. 

Note: Even if your antivirus software is disabled, you will not be able to recover your mailbox 

entirely if it is highly corrupted. 



 
 
 
 
 
 
 
 
 
 

 

 

Stellar Converter for OST-Technician 

 
User Guide 12.0 



1. About Stellar Converter for OST - Technician 

 
Stellar Converter for OST - Technician, offers a complete solution to convert OST file to multiple 

formats including all contents such as e-mails, attachments, contacts, calendars, tasks, notes 

and journals. The software also provides the option to split and compress mailbox while saving OST 

file to PST format. 

After OST file conversion, the software previews the original OST file mailbox items along with their 

content in a three-pane structure. 

 
Key features: 

 
¶ Supported Output Formats - Provides options to export OST file to Live Exchange Server, 

Office 365, Outlook Profile and PST formats. Also supports DBX, MBOX, MSG, EML, RTF, 

HTML and PDF formats. 

¶ Batch Conversion - Provides an option to convert multiple OST files to PST files in a 

single conversion cycle. 

¶ Selective Conversion - Provides options to only save selected emails as per requirement. 

 
¶ Encrypted Files Support - Supports the conversion of encrypted OST files. 

 
¶ Recover Deleted E-mails - Supports preview and conversion of deleted items. 

 
¶ Auto split PST file ï Option to auto split new PST file at approximately 45 GB in size. 

 
¶ Apply Advance Filter ï Option to filter specific and particular mailboxes from converted file. 

 
¶ Find Option - Provides an option to find emails faster. 

 
¶ Resume Function - Provides an option to resume the process at a later stage by 

saving a scan information file. 

¶ Compress and Split PST files - Provides an option to split or compress mailbox while 

saving the output in PST format. 

¶ Preview Before Saving - Provides a preview of converted mail items in a three- 

pane structure. 

¶ Save Contacts - Provides an option to save all contacts in CSV file format. 

 
¶ Quick Save Option - Provides an option to right-click on emails listed on the preview 

section to save them in MSG, EML, RTF, HTML and PDF formats. 

¶ Source OST File Support - Supports MS Outlook 2021, 2019, 2016, 2013, 2010 and 

2007 OST files. 



¶ MS Outlook Support - Supports MS Office 365, 2021, 2019, 2016, 2013, 2010 and 2007. 

 
¶ Operating System - Compatible with Windows 11, Windows 10, Windows 8.1, 

Windows 8 and Windows 7 (x64 edition only). 



2. User Interface 

 
Stellar Converter for OST has a simple and easy to use Graphical User Interface (GUI). The 

GUI of Stellar Converter for OST resembles the GUI of MS Office. 

After launching the software, the main user interface appears as shown below: 
 

The user interface contains ribbons, buttons and preview tabs that allow you to access various 

features of the software with ease. 



2.1. Ribbons 

1. File Ribbon 
 

¶ Select Outlook Data File: Use this option to select for outlook data file (.ost). 

 
¶ Save Converted File: Use this option to save the converted OST file at your 

specified location. 

¶ Exit: Use this option to close the software. 
 
 

 
2. Home Ribbon 

 

¶ Select Outlook Data File: Use this option to select for outlook data file (.ost). 

 
¶ Save Converted File: Use this option to save the converted OST file at your 

specified location. 

¶ Find Message: Use this option to search for specific emails and messages from the 

list of the scanned emails. 

¶ Save Scan: Use this option to save the scanned information of the file. 

 
¶ Load Scan: Use this option to load the saved scan file. 

 
¶ Batch Conversion: Use this option to convert multiple OST files to PST files. 



3. View Ribbon 
 

¶ Switch Reading Pane: Use this option to switch between horizontal and vertical views of 

the reading pane. 

¶ Log Report: Use this option to view the log report. 
 
 

 
4. Tools Ribbon 

 

¶ Save All Contacts as CSV: Use this option to save all contacts in CSV file format. 

 
¶ Relink Attachments: Use this button to relink the attachment folder. 

 
¶ Update Wizard: Use this option to update the software. 

 
 

 
5. Calendar Ribbon 

 

¶ Day: Use this option to list all the entries of a particular day from the list of the 

scanned emails. 

¶ Work Week: Use this option to list all the entries of a workweek. 

 
¶ Week: Use this option to list all the entries of a week. 

 
¶ Month: Use this option to list all the entries for a particular month. 

 
¶ GoTo: Use this option to list all the entries of the current date or any particular date. 



6. Activation Ribbon 
 

¶ Activation: Use this option to activate the software after purchasing. 
 
 

 
7. Help Ribbon 

 

¶ Help Topics: Use this option to open the help manual of the software. 

 
¶ Knowledgebase: Use this option to visit the Knowledgebase articles of stellarinfo.com. 

 
¶ Support: Use this option to visit the support page of stellarinfo.com. 

 
¶ About: Use this option to read information about the software. 

 
 

 
8. Buy Now Ribbon 

 

¶ Buy Online: Use this option to buy Stellar Toolkit for Outlook. 
 
 

 
9. Language Menu 

 

http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php


¶ Language: Use this option to change the language of the software. In the drop-down menu, 

you will find the following language options: English, French, German, Italian and 

Spanish and Japanese. 

 

 
10. Style Ribbon 

 

¶ Style: Use this option to switch between various themes for the software, as per your 

choice. Stellar Converter for OST - Technician offers the following themes: Office 

2016 Colorful Theme and Office 2016 White Theme. 



2.2. Preview Tabs 

Stellar Converter for OST provides options to navigate between Mails, Calendar, Contacts, 

Tasks, Notes and Journal views at the bottom of the left pane. It also allows you to 

reset/modify the Navigation Pane Options. 

 

 

 

¶ Click Mail  icon to preview all the emails saved in the selected mailbox. 
 

 

 

¶ Click Calendar  icon to preview the calendar saved in the selected mailbox. It 

displays the schedule in an organized and efficient manner. 

 



Calendar window displays the schedule created in the selected mailbox. 



 

 

 
Click this button to list all the entries of one particular day from the 

calendar. 

 

 

 

 
Click this button to list all the entries of a workweek. 

 

 

 

 
Click this button to list all the entries of a week. 

 

 

 

 
Click this button to list all the entries of a particular month. 

 

 

 

 
Click this button to list all the entries of the current date, or a 

particular day (any single day except the current date). 

 

 

¶ Click Contacts  icon to preview all the contacts saved in the selected mailbox. 
 



¶ Click Tasks  icon to preview all the tasks saved in the selected mailbox. 
 

¶ Click Notes  icon to preview all the notes saved in the selected mailbox. 
 



¶ Click Journal  icon to preview all the created journal entries saved in the 

selected mailbox. 
 

¶ Click  and select Navigation Pane Options. This will open the Navigation 
Pane Options window. 

 
 

 
To modify/reset the navigation pane options: 

 

¶ Check/ uncheck the preview tab that you want to add/ remove from the list. 

 
¶ Click Move Up/ Move Down button to modify the order of the preview tabs. 

Move Up button will shift the desired tab upwards and Move Down button will 

shift the desired tab downwards in the list. 

¶ Click Reset to go back to the default list of preview tabs. 

 
¶ Click OK to save the changes. 



3. Working with the Software 

3.1. Select and Convert OST File 

 
3.2. Preview Converted OST File 

 
3.3. Find, View and Save a Single Message 

 
3.4. Save Converted OST File 

 
3.5. Relink Attachment Folder 

 
3.6. Save All Contacts as CSV 

 
3.7. Save Log Report 

 
3.8. Save and Load Scan Information 

 
3.9. How to Apply Advance Filter 

 
3.10. Importing PST file in MS Outlook 

 
3.11. Changing the Software Language. 



3.1. Select and Convert OST File 

If you know the location of OST files, then you can directly specify the location and start the conversion 

of the selected file. If you do not know the location, then you can search the required OST file, 

using the find functionality of Stellar Converter for OST. 

Steps to select and convert OST file: 

 
1. Run Stellar Converter for OST. 

 
2. Select OST File for Conversion window appears when the software opens. Alternatively, 

you can open Select Outlook Data File for Conversion window from File menu or Home 

ribbon. 

 

 
3. There are two tabs available to select the Outlook Data file files: Choose mailbox Manually 

and Profile List. 

 
I. Choose mailbox Manually: This is the default selected tab. Use this tab when the file 

location is known. 

 
There are two options to select OST file: Browse and Find: 

 
i. Browse: Use Browse button if you exactly know the location of the OST file on 

your system. 

 
a) Click Browse. Locate and select the OST file and click Open. 



 

b) Click Convert to start the conversion process. 
 

c) After the process is completed a Conversion Complete dialog box appears 

with a message ñSelected file has been convertedò. 

 

d) Click OK. 
 

 
ii. Find: Use Find button to search OST file from the selected system drive. 



a) Click Find. Find Outlook Mailbox window appears. 
 

b) Select the drive from the drop-down list. However, you can only select one 

drive at a time. 

c) Click Find button to start the search process. 

d) If you want to start the search process, Click Stop. 

e) After the search is finished, Find Complete dialog box appears with the 

number of OST files found. Click OK. 

f) The list of OST files found in the selected drive is displayed in the Results 

section. Select the file you want to convert, only one file can be selected at a 

time. 

Note: If you want to clear the search result, click Clear List. 

g) Click Convert to start the conversion process. 

h) After the process is completed a Conversion Complete dialog box appears 

with a message ñSelected file has been convertedò. 

 

i) Click OK. 
 
 

 
II. Profile List: Use this tab to list all the configured outlook profiles from your system. 

 
a) Click this tab, List Configured Profiles dialog box appears. 

Note: You only need to list configured files once. 



 

b) Click List Profiles button to list all the outlook profiles from your system. 

Total number of listed profiles appear. 

 

c) From the list select the required outlook profile. 

d) Click Convert to start the conversion process. 

e) After the process is completed a Conversion Complete dialog box appears 

with a message ñSelected file has been convertedò. 

 

f) Click OK to complete the process. 

Note: To save the converted file, click Save Converted File from Home menu. 

 
After the conversion is complete, the software provides a preview of the converted OST file. 

See Preview Converted OST File, for more details. 



3.2. Preview Converted OST File 

Stellar Converter for OST shows the preview after the OST file is converted. The preview of 

the mailbox data is available in a three-pane structure containing: Left pane, Middle pane and 

Right pane, which are explained below in detail: 

 

 

¶ The left pane provides the navigation tree, displaying the files with its mailboxes, 

folders and sub-folders. Select the desired mailbox/folder/sub-folder from this pane. 

¶ The middle pane provides a list of mailbox items, in a tabular format, of the 

selected mailbox/folder/sub-folder. The pane contains the following columns: 

o Deleted icon: Shows the deleted emails of the selected mailbox, in red color. 

o Importance icon: Signifies that the particular mail is sent with high importance. 

o Type: Shows the type of mail item it has. 

o Attachments: Shows an attachment icon if the particular mail item contains 

an attachment. 

o From: Shows the email address of the sender. 

o To: Shows the email address of the receiver. 

o Subject: Shows the email subject. 

o Date: Shows the date and time when the email was sent. 

Tip: You can change the order of the above-given columns as per your requirement. 

Click and hold on the column name and drag the column to the desired location to 

change it. 

¶ The right pane provides the preview of the mail item that you select from the middle 

pane. It shows the following information: 



o Subject: Shows the subject of the email. 

o From: Shows the email address of the sender. 

o To: Shows the email address of the receiver. 

o Attachments: Shows the attachments of the selected mailbox item. 

o Body: Shows the preview of the body of the selected mail item. 

Note: To switch between vertical and horizontal reading panes, click Switch Reading Pane icon 

in View ribbon. 

 

 

Additional Options: 
 

¶ Quick search: The software provides quick search options for Mails. In the middle pane 

below the table headings, type the keywords in the search bar of a particular column. The 

columns that support quick search are From, To, Subject, and Date. 

 

 
¶ Sorting columns: You can sort the mails and media items using the table headers in the 

middle pane. Click on the column heading to sort the column in ascending order. Click on 

the same heading again to change the sorting order from ascending to descending and 

vice versa. 
 

Alternatively, you can right-click on the column and arrange it accordingly, using Arrange By 

option. It can be arranged by Date, From, To, Subject, Type, Attachment, Deleted, Importance 

or Show in Groups option. 



 



3.3. Find, View and Save a Single Message 

Stellar Converter for OST allows you to find and convert a particular message from the OST file. 

The software offers a Find Message feature, which helps you narrow the search using various 

search options. You can save a message directly from the search result in MSG, EML, RTF, HTML, 

PDF format. 

To find messages: 

 
1. Click Find Message in Home ribbon. Find Message window opens. 

 
2. Specify the search criteria in Find Message window: 

 

¶ In To field, specify all or few characters of email ids of recipients. Keywords 

should be separated by a semicolon (;). 

¶ In From field, specify all or few characters of email ids of senders. Keywords 

should be separated by a semicolon (;). 

¶ In Subject field, specify the subject that you need to search. 

 
¶ If you want to search for emails sent or received on a particular date, select 

Select Date Field checkbox, and select date from Date drop box. 

 
3. Click Find Now button to start the search. 

 

To view me s sa ge s : 

 
1. After the search is complete, a list of emails that match the search criteria is displayed. 

 
2. Double-click on an email to open it in a new window. 

 
To save messages: 



To save any message from the search result list, right-click on it and: 

 

¶ Select Save as MSG to save the message in MSG format. 

¶ Select Save as EML to save the message in EML format. 

¶ Select Save as RTF to save the message in RTF format. 

¶ Select Save as HTML to save the message in HTML format. 

¶ Select Save as PDF to save the message in PDF format. 



3.4. Save Converted OST File 

There are many options to save converted file. Refer to the following topics as per your 

requirement: 

3.4.1. Save as PST Format. 

 
3.4.2. Export to Existing Outlook Profile 

 
3.4.3. Export to Microsoft365 

 
3.4.4. Export to Live Exchange Server. 

 
3.4.5. Save as Other Formats 

Note: Before you start the saving process of converted outlook data file make sure that Microsoft 

Outlook is closed. 



3.4.1. Save as PST Format 

Stellar Converter for OST provides a feature to save converted files in either normal, compact 

or split PST files. Refer to the following topics as per your requirements. 

 
3.4.1.1. Save as PST Normally 

3.4.1.2. Compact and Save PST File 

3.4.1.3. Split and Save PST File 



3.4.1.1. Save as PST Normally 

 
Stellar Converter for OST allows you to save the converted mails to a PST file. The software provides 

options to compress, split and filter file before saving. 

 

Steps to save as PST format: 

 
1. Run Stellar Converter for OST. 

 
2. See Select and Convert OST File, to know how to select and convert the file. 

 
3. Click Save Converted File from Home ribbon to open a Save As window. 

 

4. Choose Save As PST and click Next. 

5. Save as PST window appears. Choose Save PST Normally option and click Next. 
 

6. Selection Destination screen appears. Click Browse to save converted OST file at specified 

destination. 



 

Note: 

¶ Recover Deleted Items checkbox is selected by default, uncheck it if recover deleted 

items is not required. 

¶ Auto split PST file check box is selected by default, uncheck it if you do not want to split 
converted OST file. This option helps to auto split new PST file at approximately 45 GB in size. 

¶ Click Apply Advance Filter if you want to apply filter on the converted files. 

 
7. Click OK. 

 
8. After the saving process is completed, Saving Complete dialog box appears. It shows the 

path and the size of the converted file. 

 

 
9. Click How to import PST file? To know how to import PST file in MS Outlook. 

10. Click OK to complete the process. 



3.4.1.2. Compact and Save PST File 

Stellar Converter for OST, compact and save PST file feature compresses the PST file and decrease 

the size acquired by them in the disk. This enhances the greater use of memory and also saves 

PST file from being corrupted. 

There are four options to compact and save PST file. Refer to the following options as per 

requirement: 

1. Compress all attachments in new PST 
 

2. Extract and save attachments to a folder (No interlinking is lost) 

 
3. Remove all attachments to new PST 



3.4.1.2.1. Compress all attachments in new PST 

You can use this option to compress all the attachments of the emails in the new PST file. 

The compressed attachments remain in the new PST file. 

Here are the steps to compress all attachments in a new PST file: 

 
1. Run Stellar Converter for OST. 

 
2. See Select and Convert OST File, to know how to select and convert the file. 

 
3. Click Save Converted File from Home ribbon to open a Save As window. 

 

4. Choose Save as PST option and click Next. 

 
5. Save as PST window appears, choose Compact and Save PST and click Next. 

 

 
6. Compact PST window appears, choose Compress all attachments in new 

PST option and click Next. 

 



7. Select Destination screen appears, click Browse to save Converted OST file at 

specified destination. 

 

 
Note: 

 
¶ Recover Deleted Items check box is selected by default, uncheck it if 

recover deleted items is not required. 

¶ Auto split PST file checkbox is selected by default, uncheck it if you do 

not want to split converted OST file. This option helps to auto split new 

PST file at approximately 45 GB in size. 

¶ Click Apply Advance Filter if you want to apply filter on the converted 

files. 

8. Click OK to start the saving process. 

 

9. After the saving process is completed, Saving Complete dialog box appears. It shows the 

path and size of the converted file. 

 

 
10. Click on óHow to import PST file?ô to know how to import PST file in MS Outlook. 

 

11. Click OK to complete the process. 



3.4.1.2.2. Extract and save attachments to a folder (No 

interlinking is lost) 

You can use this option to extract attachments from the PST file and then save them in a new folder 

in their original form. A shortcut to the extracted attachments remains in the new PST file.This option 

will extract attachments to a new folder without making any changes to the contentor the 

attachments of the original file. 

Steps to extract and save attachments of a PST file to a folder (No interlinking is 

lost): 

1. Run Stellar Converter for OST. 

 
2. See Select and Convert OST File, to know how to select and convert the file. 

 
3. Click Save Converted File from Home ribbon to open a Save As window. 

 

4. Choose Save as PST option and click Next. 

 
5. Save as PST window appears, choose Compact and Save PST and click Next. 

 

6. Compact PST window appears, choose Extract and save attachments to a folder 

(No interlinking is lost) option and click Next. 



 

 
Note: If you want to know how to relink attachments, click óHow to relink attachment folder?ô 

 
7. Select Destination screen appears, click Browse to save converted OST file at specified 

destination. 

 

 
Note: 

 
¶ Recover Deleted Items checkbox is selected by default. Uncheck it if 

recover deleted items is not required. 

¶ Auto split PST file check box is selected by default, uncheck it if you do not want to 

split converted OST file. This option helps to auto split new PST file at approximately 45 

GB in size. 

¶ Click Apply Advance Filter if you want to apply filter on the converted files. 

 
8. Click OK to start the saving process. 

 
9. After the saving process is completed, Saving Complete dialog box appears. It shows 

the path and size of the converted file. 



 

 
10. Click óHow to import PST file?ô to know how to import the PST file in MS Outlook. 

 
11. Click OK to complete the process. 



3.4.1.2.3. Remove all attachments in new PST 

You can use this option to remove all the attachments in new PST file. This option retains only 

the mail but not any of its attachments. No changes are made to the original PST file. 

Steps to remove all attachments in new PST: 

 
1. Run Stellar Converter for OST. 

 
2. See Select and Convert OST File, to know how to select and convert the file. 

 
3. Click Save Converted File from Home ribbon to open a Save As window. 

 

4. Choose Save as PST option and click Next. 

 
5. Save as PST window appears. Choose Compact and Save PST and click Next. 

 

6. Compact PST  window  appears, choose Remove all attachments in new PST 

option and click Next. 
 



7. Select Destination screen appears, click Browse to save converted OST file at specified 

destination. 

 

 
Note: 

 
¶ Recover Deleted Items check box is selected by default, uncheck it if 

recover deleted items are not required. 

¶ Auto split PST file check box is selected by default, uncheck it if you do 

not want to split converted OST file. This option helps to auto split new 

PST file at approximately 45 GB in size. 

¶ Click Apply Advance Filter if you want apply filter on the converted files. 

 
8. Click OK to start saving the process. 

 
9. After the saving process is completed, Saving Complete dialog box appears. It shows the 

path and size of the converted file. 

 

 
10. Click óHow to import PST file?ô to know how to import the PST file in MS Outlook. 

 
11. Click OK to complete the process. 



3.4.1.3. Split and Save PST File 

Stellar Converter for OST allows you to split converted PST files into different sizes. You can 

split file into various sizes up to the maximum size of 50 GB. 

 
For large files, Stellar Converter for OST automatically splits the new PST file into small sizes. 

The size of the split files will depend on the version of Outlook installed on your computer: 

 
1. If you have Outlook 2007 installed, the new PST will split at approximately 18 GB size. 

2. If you have Outlook 2010 or above installed, the new PST will split at approximately 45 

GB in size. 

Note: You can use Split and Save PST option when converted mailbox size is more than 

1GB. 

 

 
Steps to Split and Save PST file by size: 

1. Run Stellar Converter for OST. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open Save As window. 
 

4. Select Save As PST option and click Next. 

5. Save as PST window appears. Choose Split and Save PST option and then click 

Next. 
 

6. Split PST screen appears. In Select size box, type or select the size as per your 



requirement to split the converted mailbox. 

Note: You can split converted mailboxes into many parts to the maximum size of 50 

GB. 

7. Click Next. Select Destination screen appears. 
 

8. Click Browse to save converted outlook data file at specified destination. 
 

 

Note: 

¶ Recover Deleted Items check box is selected by default, uncheck it if recover deleted 

items are not required. 

¶ Auto split PST file check box is selected by default, uncheck it if you do not want 

to split converted PST file. This option helps to auto split new PST file at approximately 

45 GB in size. 

¶ Click Apply Advance Filter if you want to apply filter on the converted files. 

9. Click OK. 

10. After the saving process is completed, Saving Complete dialog box appears. It 

shows the path and size of the converted file. 

 



11. Click óHow to import PST file?ô to know how to import PST file in MS Outlook. 

12. Click Ok to complete the process. 



3.4.2. Export to Existing Outlook Profile 

 
Stellar Converter for OST provides a feature to export PST files to the existing outlook profile. 

 
Steps to export OST file to Existing Outlook profile: 

 
1. Run Stellar Converter for OST. 

 
2. See Select and Convert OST File, to know how to select and convert the file. 

 
3. Click Save Converted File from Home ribbon to open a Save As window. 

 

4. Choose Export to Existing Outlook Profiles option and click Next. 

5. Select Outlook Profile window is displayed. Select an Outlook profile from the list of 

MS Outlook profiles shown. 

Note: If the outlook profile is password protected, Enter Password window will appear. 

Enter the password and click OK. 

Note: If you don't have any Outlook profile, by default an outlook profile will be generated 

and converted mailboxes will be saved in the default location. 

 
Note: 



¶ Recover Deleted Items check box is selected by default, uncheck it if recover deleted 

items are not required. 

 

¶ Click Apply Advance Filter if you want to apply filter on the converted files. 
 

 
6. Click OK to start saving the process. 

 
7. After the saving process is completed, Saving Complete dialog box appears. It shows 

the path and size of the converted file. 
 

8. Click OK to complete the process. 



3.4.3. Export to Microsoft365 

Stellar Converter for OST provides a feature to export the converted mailbox to your Microsoft 

365 account. 

 
Note: 

 

¶ To use Export to Microsoft365 option, make sure that you have an active internet 

connection. 

 

¶ Before saving the converted mailbox to Microsoft365, make sure that Microsoft365 

account is configured in MS Outlook application. 

 

¶ Online mailbox data cannot get exported to Microsoft 365. You can only export your 

offline mailbox data to Microsoft 365. 

 
Steps to export converted mailbox to Microsoft 365: 

 
1. Run Stellar Converter for OST. 

 
2. See Select and Convert OST File, to know how to select and convert the file. 

 

3. Click Save Converted File from Home ribbon to open a Save As window. 
 

4. Select Export to Microsoft 365 and click Next. 

 

5. Microsoft 365 Login Details window appears. Select only Microsoft 365 profile name 

from the dropdown list. 

 



Note: 

 

¶ Recover Deleted Items check box is selected by default, uncheck it if recover 

deleted items are not required. 

 

¶ Click Apply Advance Filter if you want to apply filter on the converted files. 

 
6. Click OK to start the saving process. 

7. After the saving process is completed, Export to Microsoft365 dialog box appears 

with a message ñData successfully exported to Microsoft 365ò. 

 

8. Click OK to complete the process. 



3.4.4. Export to Live Exchange Server 

 
Using Stellar Converter for OST provides a feature to connect exchange server through Admin 

or User credentials and export the converted mailbox to a Live Exchange Server. 

Steps to export the  converted mailbox to a Live Exchange Server: 

 
1. Run Stellar Converter for OST. 

 
2. See Select and Convert OST File, to know how to select and convert the file 

 
3. Click Save Converted File from Home ribbon to open a Save As window. 

 

4. Select Export to Live Exchange Server option from Save As window and click Next. 

Exchange Server Details window appears. 

 

5. There are two options: 

 
(a) Login with Administrator account of Domain: Use this option when you have 

administrator credential details. 

 
(i) Choose Login with Administrator account of Domain radio button. 

 
(ii) Enter Exchange Server Name in the text field. 



Note: Exchange 2010 and Higher check box is by default selected, unselect it if not 

required. 

 
(iii) Click Next. 

 
(iv) Enter Details dialog box appears. 

 

(v) Under Exchange Admin Details section enter Admin Email ID, Admin Name, 

and Admin Password. 

 
(vi) Under Destination Mailbox Details section enter Mailbox Email ID. 

 
Note: 

 

¶ Recover Deleted Items check box is by default selected, unselect it if not required. 

¶ Refer to section Apply Advance Filter, to know how to apply filter. 

 
(vii) Click OK to connect to your mailbox. 

 
(b) Login with Domain User Account: Use this option when you have user account credential 

details to connect live exchange server. 

 
(i) Choose Login with Domain User Account radio button. 

 
(ii) Enter Exchange Server Name in the text field. 

 

Note: Exchange 2010 and Higher check box is by default selected, unselect it if not 

required. This software will not support Exchange server below 2010. 

 
(iii) Click Next. 

 
(iv) Enter Exchange Mailbox Details dialog box appears. 



 

(v) Enter Mailbox Email ID, Mailbox Name, and Mailbox Password. 

 
Note: 

 

¶ Recover Deleted Items check box is by default selected, unselect it if not required. 

¶ Refer to section Apply Advance Filter, to know how to apply filter. 

 
(vi) Click OK to connect to your exchange server mailbox. 

 
(vii) Saving process starts, if you want to stop the process click Stop button. 

 

(viii) After successful saving process, saving complete dialog box appears with message, 

"Data Export Successful". 

 

(ix) Click OK to complete the process. 

 

Note: The system, from which you want to export OST files to the exchange server, must be a 

member of the server domain. 



3.4.5. Save as Other Formats 

Stellar Converter for OST allows you to save the converted file in MSG, EML, RTF, PDF, HTML and 

MBOX formats. With the Naming Convention option, the mail items can be saved with specific names 

such as Subject of the e-mail, Date of the e-mail, and Sender of the e-mail. 

 
Steps to save the converted file: 

 
1. Run Stellar Converter for OST. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

4. From Save As window, select Other Formats option. Drop-down list box enables. 

 

 
5. Select any one of the formats (MSG, EML, RTF, PDF, HTML or MBOX) from the item list and 

click Next. 

 
6. Naming Convention window appears, select anyone from the following options: 

 
o Subject - The converted file will be saved with the name as the respective email 

message's subject. 

o Subject + Date (DD-MM-YYYY) - The converted file will be saved with the name as the 

respective email message's subject and date. 

o Date (YYYY-MM-DD) + Subject - The converted file will be saved with the name as the 

respective email message's date and subject. 

o From + Subject + Date (YYYY-MM-DD) - The converted file will be saved with the name 

of the respective email message's sender, subject, and date. 

o Date (DD-MM-YYYY) + From + Subject - The converted file will be saved with the name 

of the respective email message's date, sender, and subject 

o Date (YYYY-MM-DD) + From + Subject - The converted file will be saved with the name 

of the respective email message's date, sender, and subject. 



o Date (MM-DD-YYYY) + Subject + From - The converted file will be saved with the name 

of the respective email message's date, subject, and sender. 

 

 
7. Click Next. 

8. Select Destination screen appears. Click Browse to save converted file at specified 

destination. 

 

 
Note: 

 

¶ Recover Deleted Items check box is selected by default, uncheck it if convert deleted 

items are not required. 

¶ Click Apply Advance Filter if you want to apply filter on the converted files. 

 
9. Click OK. A window appears and shows the status of Saving in progress. 

10. After successful saving completion, a Saving Complete dialog box appears with a 

message "Selected messages saved successfully". 

 

 
11. Click on 'Open containing folder' link to view the saved messages. 



3.5. Relink Attachment Folder 

You need to relink the attachment folder when you move it after using Extract and save attachments 

to a folder (No interlinking is lost) or Extract and save attachments to a folder (No interlinking 

is lost) option. 

To do this: 

 
1. Click Relink Attachments from Tools ribbon. 

 

2. Click on Select PST and Select Folder button to browse to and select the converted PST 

file, and its attachment folder. 

3. Click on Relink button to relink the attachments to the emails. 

Note: You can move the attachments folder to a different location on the same local 

machine, or you can move both the converted PST file and the attachments folder to 

another machine. 



3.6. Save All Contacts as CSV 

To save all contacts in CSV file: 

 
1. Run Stellar Converter for OST software. 

 
2. See Select and Convert OST File, to know how to select and convert the file. 

 
3. After all the folders and their items are listed, click on Save All Contacts as CSV button 

from Tools ribbon. 

 
4. A dialog box opens. Using Browse button, select the desired location to save the CSV file. 

 

5. Click OK. The file will get saved in the desired format. 
 

Note: Recover Deleted Contacts check box is selected by default, uncheck it if 

converted deleted contacts are not required. 

. 



3.7. Save Log Report 

With Stellar Converter for OST, you can save the Log Report to analyze the conversion 

process at a later stage. 

Steps to save log report: 

 
1. From View ribbon, select Log Report. 

 
2. In the Log Report window, click Save Log. 

 

3. In Save As window, specify the location where you want to save the log file. Click Save. 



3.8. Save and Load Scan Information 

This option allows you to save the scanned information of files using the "Save Scan Info" 

option and later load the saved scan (DAT) file using the "Load Scan" option. It saves time in 

restoring data as we do not need to convert the OST file again. 

Steps to save scan information from the converted OST file: 

 
1. From the Home Ribbon, select Save Scan Info. 

 

2. Save Scan Information window will open. Browse to the folder where you want to save 

the scan information and click OK. The information gets saved in .DAT file format. 

3. A message box appears, click OK. 
 
 
 

 
Load Scan Information 

 
This option is used to start the conversion procedure from saved scan information or .DAT file. 

 
To load the scan information of the OST file, follow the steps given below: 

 
1. To load the scan information, click on Load Scan option from the Home Ribbon. 

 



2. Load Scan window will appear. It displays a list of saved scan information file existing in 

the system. 

3. In case the file you desire is not in the list, click Add button and select the desired DAT file. 

 
4. Click Open. 

 
5. The file you added is displayed in the load scan window. Click Remove button if you 

want to remove the save scan (.DAT) file. 

6. Click Reset button to reset the load scanned list. 

 
7. Click Load Scan button. 

 
8. A message box appears, click OK. 

Note: You can select only one file at a time to start the process of scanning. 



3.9. How to Apply Advance Filter 

Stellar Converter for OST provides an advanced filtering feature to find specific and particular 

mailboxes using Date Range filter. You can also narrow your search results by excluding specific 

sendersô IDs from all the converted mailboxes. 

 
Steps to apply advanced filter: 

 
1. In Apply Filter window, under Include section there are two check boxes: 

 

a) Include 'Junk Email' folder: Select this check box to include junk email files and folders. 

b) Include 'Delete Items' folder: Select this check box to include deleted items file and 

folder. 

 
2. From Date Range section select the specific Start Date and End Date to find the specific 

mailboxes. 

3. From Sender IDs to be excluded section enter the list of specific sendersô ID's that you don't 

want to include. 

 
a. In Add to List text field enter specific sender ID's that you don't want to include. 

 
Note: You can include only one sender ID at a time in Add to List text field. 

 
b. Then click Add to List button to list it. 

c. All the check boxes are selected by default, deselect the unrequired check boxes. 



4. Click Apply button to apply the filters. 



3.10. Importing PST file in MS Outlook 

To import PST file in Microsoft Outlook 2021 / 2019 / 2016 / 2013: 

 
1. Open Microsoft Outlook. From File Menu, select Open & Export. 

2. Select Import / Export option from the right pane. 

3. From Import and Export Wizard window, select Import from another program or file, click Next. 

4. In Import a File dialog box, select Outlook Data File (.pst), click Next. 

5. Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

6. In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

 
 

 
To import PST file in Microsoft Outlook 2010: 

 
1. Open Microsoft Outlook. From File Menu, select Open -> Import. (For MS Outlook 2013, select 

Open and Import from File Menu) 

2. From Import and Export Wizard window, select Import from another program or file, click Next. 

3. In Import a File dialog box, select Outlook Data File (.pst), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

5. In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

 
 

 
To import PST file in Microsoft Outlook 2007: 

 
1. Open Microsoft Outlook. From File menu, select Import and Export. 

2. From Import and Export Wizard window, select Import from another program or file, click Next. 

3. In Import a File dialog box, select Personal Folder File (PST), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

5. In Import Personal Folders dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 



3.11. Changing the Software Language 

To use Stellar Converter for OST in your preferred language, the software provides an option 

to select any of the desired languages. Using the Languages button, you can change the 

entire software to a different language at any time/instance without having to re-install the 

software. 

Steps to change the language of the software: 

 
1. Run Stellar Converter for OST - Technician. 

 
2. Click Language button located at the top right corner. 

 

3. A dropdown list appears with the following languages: 

 
¶ English 

 

¶ French 

 
¶ German 

 

¶ Italian 

 
¶ Spanish 

 
¶ Japanese 

 
4. Select the desired language. The software language will be changed accordingly. 



4. Frequently Asked Questions (FAQs) 

1. What does Stellar Converter for OST do? 
 

The Stellar Converter for OST converts OST file and provides options to export data to Live 

Exchange Server, Existing Outlook Profile and Office 365. Also, provides options to save data 

in PST, MSG, EML, RTF, HTML, PDF, DBX and MBOX formats. 

2. What is an OST file? 

 
OST (Offline Storage Table) file represents the user's mailbox data in offline mode. An Exchange 

account uses an offline Outlook data file i.e., OST file, to store a synchronized copy of your 

Exchange mailbox information on your local computer or the local machine. Therefore, an OST file 

is automatically created when you configure the Exchange Server account on Microsoft Outlook. 

3. I am not aware of the OST file location. How do I select the file for conversion to PST? 

 
Stellar Converter for OST can help you find OST file on your system. There is a dedicated 

Find option in the software through w h i c h  y o u  can l o c a t e  a  particular O S T  file and 

convert it. 

4. I had run the demo and can see preview correctly in convert OST window. Do I need 

to rescan the file? 

Not at all, through the Demo version, you can preview the converted file after scanning. This 

special feature has been included in the tool to make sure that you can first preview the 

conversion results of your OST file and only when you are satisfied with the results, you should 

decide to make the purchase and save your converted files. 

5. I want to recover permanently deleted emails from my OST file. Will Stellar Converter 

for OST - Technician help? 

Yes, the software scans and recover your permanently deleted emails from OST file. Before 

saving the deleted items, you can preview them as well. These deleted items will be shown in red 

color while previewing. 

6. Can we exclude the deleted items from the converted mailbox while saving? 

 
Yes, select the checkbox "Do not convert Deleted Items" to exclude the deleted items from 

the converted file. 

7. How much time will Stellar Converter for OST software takes to convert an OST file? 



The conversion time depends upon the size of the OST file and also on the number of mailbox 

items in the mailbox. 

8. I got an error "Invalid OST file" while scanning. What could be the reason? 

 
There could be the following reasons for this error message: 

 
¶ The OST file is severely corrupted or not in a state to be converted. 

 
¶ The OST file is not valid. 

 
¶ The file could not be accessed. 

 
9. I have converted my old OST file. But Iôm unable to find my contacts. How can I find 

them? 

 
You can easily locate and access your contacts by following these simple steps: 

 
¶ Import your new PST file into MS Outlook. 

 
¶ Open MS Outlook. 

 
¶ Then press "Ctrl+Shift+F". 

 
¶ "Find Message / Advanced Find" window will open. Please select "Contacts" under 

"Look For" tab. 

¶ Click on the "Browse" button and select the imported PST file. 

 
¶ Then, click "Find Now." 

 
¶ Now you will be able to see all the contacts that you were able to preview with the softwareôs 

demo version. You may select the entire contacts listed and drag it to your original 

contacts list, so that you may use it further. 

10. Can I convert an OST file of size more than 2 GB? 

 
Absolutely yes, this tool is capable of converting OST files having a size greater than 2 GB. 

Please download the demo version and scan your OST file. You can preview all emailsand other 

mailbox items that are converted into this tool. 

11. I want to analyze the conversion process. Can I see the log report at a later stage? 

 
Certainly. The software provides you an option to save and view log reports at any point in time. 

To view and save log reports just follow the following steps: 

¶ On View Ribbon, select 'View Log Report.' 

 
¶ On Stellar Converter for OST window, click 'Save Log' and save it at the desired location 

to view it any time. To know more refer to Log Report. 



12. Should Microsoft Outlook be installed in my system while I convert my OST file and 

with which version it works well? 

Microsoft Outlook is not required while converting and previewing OST file, but it must be installed 

in your system to use save options. The software is compatible with the following versions: 

Microsoft Outlook: Office 365 / 2019 / 2016 / 2013 / 2010 / 2007. 

 
13. What does the compact feature of Stellar Converter for OST do? 

 
As the name suggests, the compact feature of Stellar Converter for OST helps to reduce the 

size of converted PST files and attachments on MS Exchange Server. It has various options for 

attachments of emails that are selected for compaction and extraction. 

14. Why do I need to compact the PST files? 

 
MS Outlook stores all data such as emails, personal data, calendar, tasks, etc. in a PST file. 

Eventually, the file becomes oversized. Such PST files are prone to corruption, so you need to 

compact them. Stellar Converter for OST, has a compaction feature that helps to compact the 

PST file. 

15. Can I extract all my attachments in a separate folder while compacting the PST file? 

 

Yes, you can extract the attachments in a separate folder. There are two options to do it Extract 

and save attachments to a folder (No interlinking is lost) or Extract, compress and save 

attachments to a folder (No interlinking is lost) option. The attachments remain as shortcut 

links in the emails. 

16. I want to extract and compact the software on select folders of the PST file. Can I 

choose some selected mailbox folders in the software? 

Yes, you can apply extraction and compaction settings on only the selected folders of the PST 

file. 

17. Can I restore the links of attachments to the PST file? 

 
Yes, you can restore the links by using the Relink Attachment Folder. You need to relink the 

attachment folder when you move it after using Extract and save attachments to a folder 

(No interlinking is lost) or Extract, compress and save attachments to a folder (No 

interlinking is lost) option. 

18. I converted my OST file, but Iôm unable to open my Outlook file after the conversion. 

How can I solve this problem? 

To resolve this problem, follow the below-mentioned steps: 



¶ Open Windows -> Control Panel. 

 
¶ Double-click Mail. In the Mail Setup window, select E-mail Accounts to configure your 

email account. 

¶ After configuring, close the window and open MS Outlook. 

 
¶ To view the newly created PST file, you can either select Open -> Outlook Data File 

from 

File ribbon or, Import the PST file in MS Outlook. 

 
19. In how many ways can I split a PST file using Stellar Converter for OST?  

 
There are three ways to split a PST file using Stellar Converter for OST.  They are as follows: 

 
o By Mail ID - You can select email ids under Mail IDs scroll box to split the PST file according 

to email ids. Alternatively, you can also use the Select All / Unselect All buttons to 

select/unselect all the email ids. All selected email ids will be stored in the new PST file, 

and no change is required to be done to the source file. To know more refer to Filter 

by Mail ID 

o By Date Range - You can select Split by Date Range checkbox and then select either 

of the two options: 

Á Select in the last radio option if you want to split the PST file according to months. 

All emails that are sent and received in the specified months will be stored in the 

new PST file 

Á Select between radio option if you want to split the PST file according to a specific 

period. All emails from the specific period will be stored in the newly created PST 

file. Select the start and end date from the list boxes. To know more refer to 

Filter by Date Range 

¶ By Size - You can select Split by Size checkbox and then split the PST file to a maximum 

size of 50 GB. Either enter the digit or using an upward or downward arrow set the 

number as per your requirement. With this option, you will get multiple split PST files. 

To know more refer to Split by Size 

Note: In case you select all the three split option checkboxes (By Mail Id, By Date Range, and 

By Size), the software will queue them and will split PST files using all the three methods. 

20. I have an OST file exceeding 50 GB of size, does the new PST file generated will have the 

same size as that of source OST file? 



For large files, Stellar Converter for OST automatically splits the new PST file in small sizes. 

The size of the split files depends on the version of Outlook installed on your computer: 

If y o u  h a v e  Outlook 2 0 0 7  installed, the new P S T  will be split a t  a p p r o x im a te l y  18 GB 

size. If you have Outlook 2010 or above installed, the new PST will be split at approximately 45 

GB to 48 GB of size. 

21. When I enter the Mail ID and Password to export data to Office 365, the system 

shows an error. What can I do? 

The software shows an error because of the following reasons: 

 
¶ If the credentials (Admin ID and Password) you have entered are incorrect. 

 
¶ The admin credentials you have entered do not have required permissions to export data 

to Office 365. 

¶ There is a connection failure with the internet. In that case, check your network connection 

and try again. If your internet is working, check your firewall and anti- virus software 

settings for any blockage. 

¶ There is a server issue because of which the server is unable to create a connection with 

Office 365. Check if you can connect to Office 365 outside the Stellar Converter for OST 

software and try again. 

22. After saving my converted mailbox in PST format. How to view and access the 

mailbox items? 

After you have saved the converted mailbox in PST format, you can import the PST file in MS 

Outlook. See Importing PST file in MS Outlook, to know how to import the PST file. 

23. Can I convert multiple OST files into PST files? 

 
Yes, you can convert multiple OST files into PST files using Batch Conversion from 

Home ribbon. This feature is not available in the demo version. 
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1. About Stellar Converter for OST - Technician 

 
Stellar Converter for OST - Technician, has a  Batch Conversion Module t h a t  a l l o w s  

y o u  to convert multiple OST files to PST files. 

 
The software also provides options to convert and split files as per date or size and to create a batch 

file. A batch file can be used to resume the convert and split process at a later stage and 

contains information such as file selection, source location, destination path for the output files, 

start date, end date, size, status, or any other detail as required by the process. 

 
Key Features: 

 

¶ Batch Conversion - Converts multiple OST files to PST files in a single conversion cycle. 

¶ Recover Deleted E-mails - Supports recovery of deleted items. 

¶ Split Output PST files -Supports splitting of Mailbox files by Date or Size. 

¶ Save Preferences as a Batch File - Option to save your preferences into a batch 

file (.DAT), to resume the conversion and splitting of files at a later stage. 

¶ Preserve Source Files - The software doesn't make any changes to the original files. 

¶ Source OST File Support - Supports 2021, 2019, 2016, 2013, 2010 and 2007 OST files. 

¶ MS Outlook Support - Supports Office 365, 2021, 2019, 2016, 2013, 2010 and 2007. 



2. User Interface 

 
Batch Conversion module of Stellar Converter for OST - Technician, has a simple and 

easy Graphical User Interface (GUI), which resembles the GUI of MS Office. 

Launch Stellar Converter for OST - Technician, click Batch Conversion from the Home 

ribbon. 
 

The main user interface of the Batch conversion module appears as shown below: 
 

The user interface contains Ribbons and Buttons that allow you to access various features of the 

software with ease. 



2.1. Ribbons 

1. Home Ribbon 
 

¶ Home: Use this option to go to the home screen of the software. 

¶ Add OST: Use this option to add the OST files which you want to convert. 

¶ Find OST: Use this option to search OST files from the system. 

¶ Select Batch File: Use this option to select a batch file. 

¶ Create Batch File: Use this option to create a batch file to resume the conversion of 

selected OST files at a later stage. 

 

 
2. View Ribbon 

 

¶ Log Report: Use this option to view/save the log report. 
 
 

 
3. Activation Ribbon 

 

¶ Activation: Use this option to activate the software. 
 
 
 

4. Help Ribbon 



 

¶ Help Topics: Use this option to view the help manual for the software. 

¶ Knowledgebase: Use this option to visit Knowledgebase articles of stellarinfo.com 

¶ Support: Use this option view the support page of stellarinfo.com 

¶ About: Use this option to read information about the software. 
 
 

 
5. Buy Now Ribbon 

 

¶ Buy Online: Use this option to buy Stellar Toolkit for Outlook. 
 
 

 
6. Language Menu 

 

¶ Language: Use this option to change the language of the software. In the drop-down menu, 

you will find the following language options: English, French, German, Italian and 

Spanish. 

 

 
7. Style Ribbon 

 

¶ Style: Use this option to switch between various themes for the software, as per your choice. 

Stellar Converter for OST - Technician, offers the following themes: Office 2016 Colorful 

Theme, Office 2016 White Theme. 

https://www.stellarinfo.com/support/kb/index.php/category/convert-ost-to-pst
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php


3. Working with the software 

 
3.1. Add OST Files 

 
3.2. Find OST Files 

 
3.3. Select Conversion Option 

 
3.4. Create and Manage Batch Files 

 
3.5. View and Save Log Report 



3.1. Add OST Files 

To start the conversion process, you have to add files to the Batch Conversion module of Stellar 

Converter for OST - Technician. You can add multiple files to the software. 

Steps to add OST Files: 

 
1. Run Stellar Converter for OST - Technician. 

 
2. From Home ribbon, click Batch Conversion button. 

 

3. The Batch Conversion module appears as shown below. 
 

4. Click Add OST from Home ribbon of Batch Conversion module. 



5. An Open window appears. Browse and select the desired OST files and then click Open. 
 

 

Or, 
 
 
 

 
Or, 

 

 

¶ Click Drag & Drop to add OST button on the main interface. An Open window 

appears, choose the location from where you want to select the file. Click Open button. 

 

 

¶ Open Windows Explorer to Drag & Drop the desired files to the software. 



3.2. Find OST Files 

Stellar Converter for OST - Technician, allows you to find OST files on your computer's hard drive, 

in case you don't know their location. With the help of find OST option, you can find OST files in 

any folder, sub-folder, or in an entire volume on your system. 

Steps to find an OST File: 

 
1. Run Stellar Converter for OST - Technician. 

 
2. From Home ribbon, click Batch Conversion button. 

 

3. The Batch Conversion module appears as shown below. 
 

4. Click Find OST from Home ribbon of the Batch Conversion module. 



5. Browse for Folder window appears. Select the drive or folder you want to search for OST 

files and then click OK. 

 

6. After the completion of the searching process, a list of OST files found in the selected drive 

or folder is displayed on the screen. 



3.3. Select Conversion Option 

 
Batch Conversion Module of Stellar Converter for OST - Technician, provides you different features 

to convert Multiple OST files to PST files and also convert large OST file into smaller PSTs. Each 

option is described below, in detail. Every time a split operation is performed, a new PST file is 

created without altering the contents and structure of the original file. Thus, Stellar Converter for 

OST - Technician never causes any damage to your original file. 

1. Convert Mailbox 

2. Convert and Split Mailbox 



3.3.1. Convert Mailbox 

Convert Mailbox is one of the conversion methods to convert single or multiple OST files to PST 

files. 

Steps to convert OST File: 

 
1. Run Stellar Converter for OST - Technician. 

 
2. See Add OST Files and Find OST Files, to know how to select OST files. 

 

3. On the left pane of the screen, listed OST files are displayed. By default, they all are selected. 

Note: Uncheck the checkbox for the file where conversion is not required. 

 
4. On the right pane of the screen, conversion options are displayed. From Select 

Conversion Option section, select the Convert Mailbox option and click Convert. 

Note: If you want to change the destination path of the converted files then click 'Click here' link. 

 
Note: If you want to reset the destination path of the converted files then click 'Reset' link. 

 
Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from 

the converted file. 

5. After completion, a Conversion Complete dialog box appears with a message, 

"Conversion process completed". If you want to view the Log Report, click View Log or 

else click Cancel. 

Note: See View and Save Log Report to know the saving log report process. 

 
Note: Close Microsoft Outlook, if open, before converting the OST file. 



3.3.2. Convert and Split Mailbox 

 
Convert and Split Mailbox option allows you to convert and split mailbox files into smaller files. 

It gives two different options, choose any of them as per your requirement: 

1. Split by Date 

2. Split by Size 



3.3.2.1. Split by Date 

Split by Date is one of the conversion options which is used to convert and split mailbox file 

under a specific date range, as per your requirement. 

Steps to convert and split OST Files by Date: 

 
1. Run Stellar Converter for OST - Technician. 

 
2. See Add OST Files and Find OST Files, to know how to select OST files. 

 
3. On the left pane of the screen, listed OST files are displayed. By default, they all are selected. 

Note: Uncheck the checkbox for the file where conversion is not required. 

 

4. On the right pane of the screen, conversion options are displayed. From the Select Conversion 

Option section, select Convert and Split Mailbox option. By default, the Split by Date option 

is selected. 

¶ From the Start Date option specify the start date of the date range for the selected file. 

¶ From the End Date option specify the end date of the date range for the selected file. 

 
5. Click Convert. 

 

Note: If you want to change the destination path of the converted files then click the 'Click 

here' link. 

 
Note: If you want to reset the destination path of the converted files then click the 'Reset' link. 

 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from 

the converted file. 

6. A Save Batch File window appears. Here, selects the destination path where you want to save 

the batch file. 



7. To know more what is the batch file click on 'What is batch file?' link. 

 
8. Click OK to start the conversion process. 

 
9. After completion, a Conversion Complete dialog box appears with a message, 

"Conversion process completed". If you want to view the Log Report, click View Log or 

else click Cancel. 

Note: See View and Save Log Report to know the saving log report process. 

 
Note: Close Microsoft Outlook, if open, before converting the OST file. 



3.3.2.2. Split by Size 

Split by Size is one of the conversion options which is used to convert and split mailbox file under a 

specific size as per your requirement. 

Steps to convert and split OST Files by Size: 
 

1. Run Stellar Converter for OST - Technician. 
 

2. See Add OST Files and Find OST Files, to know how to select OST files. 

 
3. On the left pane of the screen, listed OST files are displayed. By default, they all are selected. 

Note: Uncheck the checkbox for the file where conversion is not required. 

 

4. On the right pane of the screen, conversion options are displayed. From Select Conversion 

Option section, select Convert and Split Mailbox option. Choose Split by Size option. 

¶ From the Split Size drop-down list, you can select a size to split the PST file according to 

preset sizes. By using this option, you will get multiple split PST files. You can choose 

the split file size to be either 5 GB / 10 GB / 20 GB / 30 GB or 50 GB. 

Note: All the selected OST files split-up into the same size scale as selected by you. 

 
Note: For large files, Stellar Converter for OST - Technician automatically splits the new 

PST file in small sizes. The size of the split files will depend on the version of Outlook installed on 

your computer: 

¶ If you have Outlook 2007 installed, the new PST will be split at approximately 18 GB size. 

¶ If you have Outlook 2010 or above installed, the new PST will be split at approximately 45 

GB to 48 GB of size. 



5. Click Convert. 

 
Note: If you want to change the destination path of the converted files then click the 'Click 

here' link. 

 
Note: If you want to reset the destination path of the converted files then click the 'Reset' link. 

 
Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from 

the converted file. 

6. A Save Batch File window appears. Here, selects the destination path where you want to 

save the batch file. 

7. To know more what is the batch file click on 'What is batch file?' link. 

 
8. Click OK to start the conversion process. 

 
9. After completion, a Conversion Complete dialog box appears with a message, 

"Conversion process completed". If you want to view the Log Report, click View Log or 

else click Cancel. 

Note: See View and Save Log Report to know the saving log report process. 

 
Note: Close Microsoft Outlook, if open, before converting the OST file. 



3.4. Create and Manage Batch Files 

Stellar Converter for OST - Technician, provides you an option to create a batch file. A batch 

file can be used to resume the convert and split process at a later stage and contains information such 

as file selection, source location, destination path for the output files, start date, end date, size, 

status, or any other detail as required by the process. It can also be used to review the number 

of files processed or to get information about the selected files. 

 
 

Steps to create Batch File: 

 
1. Run Stellar Converter for OST - Technician. 

 
2. See Add OST Files and Find OST Files, to know how to select OST files. 

 
3. On the left pane of the screen, listed OST files are displayed. By default, they all are selected. 

Note: Uncheck the checkbox for the file where conversion is not required. 

 
4. On the right pane of the screen, conversion options are displayed. From the Select Conversion 

Option section, select Convert and Split Mailbox option. Choose any one option, as per your 

requirement. 

Note: You can create batch file only when ''Convert and Split Mailbox" option is selected. 

 
5. From Home ribbon click Create Batch File to open Save Batch File window. 

 
6. Select the destination path to save batch file and click OK. 

 
7. A Batch File dialog box appears with a message, "Batch file created successfully". 

Note: Alternatively, Save Batch File window appears when you click on Convert. 



Steps to select Batch Files: 

 
1. Run Stellar Converter for OST - Technician. 

 
2. From Home ribbon click Batch Conversion button to open Batch Conversion module. 

 
3. From Home ribbon, click Select Batch File button. 

 
4. A Select Batch File window appears. Here, you have to select the batch file that you want 

to convert. 

5. An Open window appears. Browse and select the desired batch file and then click Open. 

 
6. It will return to the Select Batch File window, click OK. 

 
7. On the left pane of the screen, selected OST files are displayed. 

Note: Uncheck the checkbox for the OST file where conversion is not required. 

 
8. On the right pane of the screen, conversion options are displayed. 

 
Note: Batch file once created with the category either (Split by Date or Split by Size) cannot be 

changed at this stage. Also new OST files cannot be added. 

9. Click OK to start the conversion process. 

 
10. Once completed, a Conversion Complete dialog box appears with a message, 

"Conversion process completed". If you want to view the Log Report, click View Log or 

else click Cancel. 

Note: See View and Save Log Report to know the saving log report process. 

 
Note: If the Reset Selection window opens, indicating that the action will clear currently added 

OST files. Click YES to proceed. 



3.5. View and Save Log Report 

With Stellar Converter for OST - Technician, you can save the Log Report to analyze 

the conversion process at a later stage. 

Steps to save Log Report: 

 
1. From View ribbon, click Log Report. 

 
2. In the Log Report window, click Save. 

 

3. A Log Location window appears. Use the Browse button to save the Log Report at the 

desired location and click OK. 

 
 

4. Log Report Saved dialog box appears and shows the location where the Log Report is 

saved with date and time. 

5. Click OK to finish the saving process. 



4. Frequently Asked Questions (FAQs) 

1. Where is the converted file saved if I select a file from the select batch option? 

 
The converted file is saved automatically at the source file location with the same name as that 

of the file along with the log report in case you do not change the location of the  converted file. 

2. Where is my batch file saved if I don't change its path? 

 
The batch file is saved in the setup folder located under Program files as 

OST2PSTBatch_date_time_time/size.dat. 

 
3. If I select multiple files having the same name from different locations saved at a 

common destination path. Then how would I recognize my converted file? 

The converted file is saved to the destination path with the same name as that of the file along with 

the log report in case all the files have the same name is saved with format filename_0, filename_1, and 

so on. 

4. I have forgotten the path of my OST file. Can I search for the OST file using the 

software? 

 

Of course, you can search for OST files in a specific drive or folder. Click Find OST File 

option in the software to locate the OST file. 

 
5. How much time Stellar Converter for OST - Technician software takes to convert an 

OST file to PST mailbox? 

The conversion time depends upon the size of the OST file and also on the number of mailbox 

items in the mailbox. 

6. I want to analyze the conversion process. Can I see the log report at a later stage? 

 
Certainly. The software gives you an option to save and view log reports at any point in time. 

To view and save log reports follow the following steps: 

¶ On View ribbon, select 'Log Report.' 

¶ In Stellar Converter for OST - Technician window, click 'Save Log' and save it at 

the desired location for viewing at any time. To know more refer to Log Report. 

7. What is an OST file? 

 
OST (Offline Storage Table) file represents the user's mailbox data in offline mode. An Exchange 

account uses an offline Outlook data file i.e., OST file, to store a synchronized copy of your 

Exchange mailbox information on your local computer or the local machine. Therefore, an OST file 

is automatically created when you configure the Exchange Server account on 



Microsoft Outlook. 

8. What is a batch file? 

 
A batch file keeps all the settings and inputs of the user to convert and split multiple files. A batch 

file contains all the information required to convert and split OST files such as some files selected, their 

location path, destination path of the output file, start date, end date, processed status or any other 

detail as required by the process. 

It can be used as an input file once it is created. It can also be used to review the number of 

files processed or to get information about selected files. 

A batch file is created by the software itself before the initiation of the process to use the batch file 

as input to convert and split process. When a batch file is created by the software, then it has a 

file extension .DAT. 

The default location of the batch file will be in the installation folder of the software. 

 

9. I have an OST file exceeding 50 GB of size, does the new PST file generated will have 

the same size as that of source OST file? 

For large files, Stellar Converter for OST - Technician automatically splits the new PST file 

in small sizes. The size of the split files will depend on the version of Outlook installed on 

your computer: 

¶ If you have Outlook 2007 installed, the new PST will be split at approximately 18 

GB size. 

¶ If you have Outlook 2010 or above installed, the new PST will be split at 

approximately 45 GB to 48 GB of size. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Stellar Merge Mailbox for Outlook- 
Technician 

 
User Guide 2.0 



1. About Stellar Merge Mailbox for Outlook 

 
Stellar Merge Mailbox for O u t l o o k  is a user-friendly software designed to merge and create 

data of mailbox of different mail clients to a single Outlook PST mailbox. When the data 

is stored in different accounts, and you are unacquainted of how to collect and store the old and 

new data together and how to manage such a huge amount of data. The merge repair tool from 

Stellar® offers solutions for such problems. Stellar Merge Mailbox for Outlook can be used to 

merge Email, Calendars, Contacts, Journal, Notes, To-Do, and Tasks folders from multiple 

mailboxes created in different Outlook versions. 

 
Key Features 

 
¶ Merge and Create: Merges and creates data of mailboxes of different mail clients 

into a single Outlook PST mailbox. 

¶ Maintains original data integrity: Maintains the integrity of the original mailbox's 

data while merging them. 

¶ Offline Mailbox: Includes NSF, PST, or DBX mailboxes and merges them into a 

single Outlook PST mailbox. 

¶ Online Mailbox: Includes Microsoft 365, Gmail, Yahoo, or Outlook.com and merges 

them into a single Outlook PST mailbox. 

¶ Identity Folder: Includes multiple mail clients such as Apple Mail, Outlook Express, 

Opera Mail, Window Mail, Thunderbird, Spice bird, many more and merges them into 

a single Outlook PST mailbox. 

¶ Merges up to 10 mailboxes: Up to 10 mailboxes can be selected and merged at a time. 

 
¶ Creates to PST: Creates different types of mailboxes into a PST format. 

 
¶ Filter Options: Options to save merged mailboxes filter wise; Date Range filter and 

excludes all the mailboxes from the Exclude Mails From filter. 

¶ User-Defined location: Allows saving the new Outlook PST mailbox at a user- 

defined location. 

¶ Log Report: Generates a report detailing the software's performance. 

 

¶ IBM Notes Support: Supports 10.0.1, 9.0.1, 9.0, 8.5, 8.0.2, 7.0, 6.5, 6.0. 

 
¶ MS Outlook Support: Supports 2021, 2019, 2016, 2013, 2010, 2007. 

¶ Operating System: Compatible with Windows 11, Windows 10, Windows 8.1, 

Windows 8 and Windows 7 (x64 edition only). 



2. User Interface 

 
Stellar Merge Mailbox for Outlook software has a very easy to use Graphical User 

Interface. The user interface contains features required for merging multiple mailboxes up to 

limit of 10 at a time. 

 
After launching the program, you will see the main user interface as shown below: 

 

 
The user interface contains Menus and Buttons that let you access various features of the 

software with ease. 



2.1. Menus and Buttons 

 
1. File Menu 

 

 

¶ Select Mailboxes: Use this option to select Online, Offline or Mail Clients mailboxes 

and Identity folder. 

¶ Save Merged Mailbox: Use this option to save merged mailbox. 

¶ Exit: Use this option to close the software. 
 
 
 

 
2. Home Ribbon 

 

 

¶ Home: Use this option to go to the home screen of the software. 

¶ Select Mailboxes: Use this option to select Online, Offline or Mail Clients mailboxes. 

¶ Saved Merged Mailbox: Use this option to save the merged mailbox. 



3. View Ribbon 
 

 

¶ Log Report: Use this option to view the log report. 
 
 
 

 
4. Tools Ribbon 

 

 

¶ Update Wizard: Use this option to check for both, latest minor and major versions 

available online. 

 
 
 
 

5. Activation Ribbon 

 

 

 

¶ Activation: Use this option to activate the software. 



6. Help Ribbon 
 

¶ Help Topics: Use this option to view the help manual for the software. 

 

¶ Knowledgebase: Use this option to visit the Knowledgebase articles of stellarinfo.com. 

 

¶ Support: Use this option to visit the support page of stellarinfo.com. 

 

¶ About: Use this option to read information about the software. 
 
 
 

 
7. Buy Now Ribbon 

 

 

¶ Buy Online: Use this option to buy Stellar Toolkit for Outlook. 
 
 

 
8. Style Button 

 

 

¶ Style: Use this option to switch between various themes for the software, as per your 

choice. 

 
 
 

 
9. Next Button 

 

http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php


¶ Click this button to merge multiple mailboxes in a single PST file. 
 
 
 

 
10. Save Button 

 

 

¶ Click this button to save merged PST file to a destination folder. 
 
 
 

 
11. Stop Button 

 

 

¶ Click this button to stop the merge process. 



3. Working with the Software 

 
3.1. Select Mailboxes 

 
3.2. Filter Options 

 
3.3. Save Merged Mailbox 

 
3.4. Save Log Report 

 
3.5. Import PST file in MS Outlook 



3.1. Select Mailboxes 

 
With Stellar Merge Mailbox for Outlook, you can select multiple mailboxes up to 10 at a time 

and merge them into a single PST mailbox. 

 
Select mailboxes from three different options: 

 
1. Offline Mailbox 

 
2. Online Mailbox 

 
3. Identity Folder 



3.1.1. Offline Mailbox 

 
This section explains how to list and merge PST, NFS or DBX offline mailboxes into a single 

Outlook PST file. 

Note: Before you begin these procedures make sure that Microsoft Outlook is closed. 

 
Steps to Select Offline Mailbox: 

 
1. Run Stellar Merge Mailbox for Outlook application, following screen appears. 

 

 
2. Click on Select Mailboxes icon from the start page. Select Mailboxes window is 

displayed. 

 
Note: Alternatively, you can also open Select Mailboxes window from Home ribbon 

or from File menu. 

 

 
3. There are three options: Offline Mailbox, Online Mailbox and Identity Folder. 

Choose Offline Mailbox radio button. 

4. Click on Add button to select the mailboxes you want to merge. 



5. Open window is displayed. Locate and select the required NSF, PST, or DBX 

mailboxes 

and then click Open to list the selected mailboxes. 

Note: You can select up to 10 mailboxes at a time. 

Note: Before adding NSF mailboxes, make sure that IBM Notes is installed on 

your system. 

6. When mailbox selection is done, click the Close button in the Select Mailbox window. 

7. On Mailboxes selected to be merged are listed below screen, a list with mailbox 
 

 

Name, Format, Size, and Type details is displayed. 

 
8. Select the required mailbox checkbox that you want to merge, and click Next button. If 

you wish to stop the merger at any point, click Stop button. 

 
Note: You must select at least two mailboxes to continue. 

 
9. After the process is completed a Scanning Complete dialog box appears with a 

message "Selected mailboxes scanned successfully ". 

 

10. Click OK. 



3.1.2. Online Mailbox 

 
This section explains how to list and merge Microsoft365, Gmail, Yahoo, or Outlook.com 

online mailboxes into a single Outlook PST file. 

Note: Before you begin these procedures make sure that Microsoft Outlook is closed. 

 
Steps to Select Online Mailbox: 

 
1. Run Stellar Merge Mailbox for Outlook, following screen appears. 

 

2. Click on Select Mailboxes icon from the start page. Select Mailboxes window is displayed. 
 

Note: Alternatively, you can also open Select Mailboxes window from Home ribbon or 

from File menu. 

 

 
3. By default, Offline Mailbox is selected, choose Online Mailbox radio button from 

the options. 



 

 
4. Fill in the following details: 

 
a. Provider: Select the email provider from the drop-down list: Microsoft365, 

Gmail, Yahoo, or Outlook.com. 

b. Username: Enter username. 

c. Password: Enter password. 

Note: You cannot use your Gmail or Yahoo! Mail account's password while putting in your 

details. You are required to use the generated app password for merging your Gmail or 

Yahoo! mail in Stellar Merge Mailbox for Outlook as shown below. 
 



 

Note: If you choose Microsoft365 as your Provider, you will only be asked to select your 

Profile configured in MS Outlook. Make sure that MS Office 2016 and above is installed on 

your system before you connect to your Microsoft 365 account. 

Note: If you choose Outlook.com as your Provider, you will simply be asked to enter your 

Outlook account's username and password as shown below. 

 

5. Click OK to list mailbox or Close to exit. 

 
Note: You can add up to 10 online mailboxes. Each online mailbox you need to add 



individually. 

6. On Mailboxes selected to be merged are listed below screen, a list with mailbox 

Name, Format, Size, and Type details is displayed. 
 

 
7. Select the required mailbox checkbox that you want to merge, and click Next. If you 

wish to stop the merger at any point, click Stop button. 

Note: you must select at least two online mailboxes to continue. 

 
8. After the process is completed a Scanning Complete dialog box appears with a 

message "Selected mailboxes scanned successfully". 

 

9. Click OK. 



3.1.3. Identity Folder 

This section explains how to list and merge Identity Folder of mail client into a single Outlook 

PST file. There is a list of 20 options from that you can add any 10 mail client Identity Folders at 

a time and merge them into a single Outlook PST file. 

Note: Before you begin these procedures make sure that Microsoft Outlook is closed. 

 
Steps to Select Identity Folder: 

 
1. Run Stellar Merge Mailbox for Outlook, following screen appears. 

 

2. Click on Select Mailboxes icon from the start page. Select Mailboxes window is displayed. 

 
Note: Alternatively, you can also open Select Mailboxes window from Home ribbon or from 

File menu. 
 

 
3. By default, Offline Mailbox is selected, choose Identity Folder radio button from the options. 



 

4. From the Select Mail Client drop-down list, select one of the following mail clients: 

 

¶ Outlook Express 

 

¶ Window Mail 

 

¶ Window Live Mail 

 

¶ Thunderbird 

 

¶ Spicebird 

 

¶ PocoMail 

 

¶ Eudora 

 

¶ Entourage 

 

¶ AppleMail 

 

¶ Mulberry 

 

¶ SeaMonkey 

 

¶ Netscape 

 

¶ ClawsMail 

 

¶ OperaMail 

 

¶ MozillaMail 

 

¶ Evolution 

 

¶ Sylpheed 

 

¶ Cone 

 

¶ Mutt 



¶ Gnu 
 

 

 
 

5. Click on Add button to select identity folder of the selected mail client. 

Note: You can add up to 10 identity folders of mail client. Each identity folder of mail client 

you need to add individually. 

6. Browse for Folder window is displayed. Select the required identity folder and click OK. 

7. When mailbox selection is done, click Close button in the Select Mailbox window. 

8. On Mailboxes selected to be merged are listed below screen, a list with mailbox 

Name, Format, Size and Type details is displayed. 



 

9. Select the required mailbox checkbox that you want to merge and click Next. If you wish to 

stop the merger at any point, click Stop button. 

Note: You must select at least two mailboxes to continue. 

10. After the process is completed a Scanning Complete dialog box appears with a 

message ñSelected mailboxes scanned successfullyò. 

 

11. Click OK. 



3.2. Filter Options 

 
After offline, online, and mail clientsô mailboxes are selected and scanned, Stellar Merge 

Mailbox for Outlook provides different filter options to save mailboxes as per user 

preferences. 

Steps to Apply Filter Options: 

 
1. Run Stellar Merge Mailbox for Outlook. 

2. See Select Mailboxes to know how to select mailboxes. 

3. After the scanning process is completed, a window appears with a list of Mailboxes to Merge 

in the left pane and Filter Options in the right pane. It has the following filter options: 

 

 
Filter Options: 

 
(i) Date Range: Apply this filter if you want to save the mails as per the date range. 

 

¶ From: Select the date to save mails from the specified date. 

¶ To: Select the date to save mails till the specified date. 

¶ Drop-down list: Select either of the two options: 

o Only within Range, if you want to save only the mails within óFromô and 

óToô dates. 



o Exclude, if you want to save all the mails excluding those within the 

specified dates. 

(ii) Exclude Mails From: Specify senders whose data you want to exclude from 

all mailboxes. 
 

 

¶ Enter the senderôs email ID in the textbox, one at a time. 

¶ Click Add to List button to list the email IDs under the Email Address box. 

¶ Continue with same procedure mentioned above to add another email IDôs. 

¶ Check the required email Id checkbox that you want to exclude. 

¶ Click Next to proceed. 

 
Note: Click Back button, to return to the previous screen. 



3.3. Save Merged Mailbox 

 
Stellar Merge Mailbox for Outlook provides the option to save the merged mailboxes to the 

user- defined location. 

 
Note: Close Microsoft outlook, if open, before saving the merged mailboxes. 

 
Steps to Save Merged Mailbox: 

 
1. Run Stellar Merge Mailbox for Outlook. 

 
2. See Select Mailboxes, to know how to select mailboxes. 

 
3. See Filter Options, if you want to apply filter options. 

 
4. A screen is displayed to specify the destination path where merged mailboxes are to 

be saved. Click Browse. 
 

 
5. Browse for Folder window is displayed. Select the location where you wish to save 

the merged mailbox. 

 
6. Click OK, the selected path is shown in the Destination Path textbox. 

 
7. After the destination path is selected, click Save button to save the mailbox. 

 
Note: If you wish to stop the saving process, click Stop to abort the operation. 



 

 
8. After the process is completed, a Mailboxes merged dialog box appears with 

a message "Merge Mailbox saved successfully". 

 

9. Click on Open Containing Folder link, if you directly want to go to the location 

where merged mailboxes are saved. 

10. Click OK to close the dialog box. 

 
Note: Click Back button, to return to the previous screen. 



3.4. Save Log Report 

 
Stellar Merge Mailbox for Outlook creates a report in the background that records the 

process and activities executed by the user and the software, that report is called a Log 

Report. The report shows the details of the ongoing process. The details include product 

name, file/folder name, process time, start time, end time, size of the selected files, and more. 
 

 
Steps to Save a Log Report: 

 
1. From View ribbon, click on Log Report icon. 

2. Log Report window is displayed as shown below: 
 

3. Click on Save. Save Log window is displayed. 
 

4. Click Browse to choose the path where you want to save the log report and click OK. 

5. After the process is completed, Log saved dialog box appears. It shows the path of 

saved log report. 



 

6. Click Ok to close the dialog box. 



3.5. Import PST file in MS Outlook 

 
Steps to Import PST file in Microsoft Outlook 2021 / 2019 / 2016 / 2013: 

 
1. Open Microsoft Outlook. From File Menu, select Open & Export. 

2. Select Import / Export option from the right pane. 

3. From Import and Export Wizard window, select Import from another program or file, click 

Next. 

4. In Import a File dialog box, select Outlook Data File (.pst), click Next. 

5. Click Browse to locate the PST file that needs to be imported. In the options box, 

select an appropriate option. Click Next. 

6. In Import Outlook Data File dialog box, select the folders that should be imported in 

Microsoft Outlook. Click Finish. 

 

 
Steps to Import PST file in Microsoft Outlook 2010: 

 
1. Open Microsoft Outlook. From File Menu, select Open -> Import. (For MS Outlook 2013, 

select Open and Import from File Menu) 

2. From Import and Export Wizard window, select Import from another program or file, click 

Next. 

3. In Import a File dialog box, select Outlook Data File (.pst), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, 

select an appropriate option. Click Next. 

5. In Import Outlook Data File dialog box, select the folders that should be imported in 

Microsoft Outlook. Click Finish. 

 
Steps to Import PST file in Microsoft Outlook 2007: 

 
1. Open Microsoft Outlook. From File menu, select Import and Export. 

2. From Import and Export Wizard window, select Import from another program or file, click 

Next. 

3. In Import a File dialog box, select Personal Folder File (PST), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, 

select an appropriate option. Click Next. 

5. In Import Personal Folders dialog box, select the folders that should be imported in 



Microsoft Outlook. Click Finish. 



4. Frequently Asked Questions (FAQs) 

 
1. What does Stellar Merge Mailbox for Outlook do? 

 
Stellar Merge Mailbox for Outlook is a merging software that merges multiple mail clients and 

creates them into a single Outlook PST mailbox. With Stellar Merge Mailbox for Outlook you can 

select multiple mail clients up to 10 at a time from different options like Offline Mailbox, Online 

Mailbox, and Identity Folder. Use different filter options and save the merged mailboxes at a user- 

defined location. 

 
2. Is it necessary that óIBM Notesô (formerly Lotus Notes) and óMicrosoft 

Outlookô be installed on the computer for merging NSF files into a single 

Outlook PST file? 

Yes, to successfully merge multi-NSF mailboxes into a single Outlook PST file, you need to install 

both IBM Notes (formerly Lotus Notes) and MS Outlook on the computer where you want to perform 

the merging mailbox procedures. 

3. Iôm adding multiple mailboxes but the software shows ñmailbox Limit Reachedò. 

How many should I add then? 

 
The software only adds 10 mailboxes at a single time. 

 
4. What would be the combination of 10 mailboxes? 

 
You can a d d  any combination o f  m a i l b o x e s  from  Offline, Online or Identity Folder  options  

up to a maximum of 10 mailboxes in a single merge operation. If you wish to add 10 mailboxes 

from any individual option that also you can do and merge them in to a single PST file. 

 
5. What are the different types of file formats that Stellar Merge Mailbox for Outlook 

can create into a single PST file? 

 
PST, DBX, and NSF are the file formats that Stellar Merge Mailbox for Outlook merges into 

a single PST mailbox. 

 
6. I want to save my merged mailboxes as per the date range. Can I do it? 

 
Yes, you can apply the date range filter to save the merged mailboxes. See Filter Options to know 

more. 

7. How should I select the mailboxes? 

 
See Select Mailboxes section for detailed instructions. 



8. How much time the software will take to merge and create the mailboxes? 

 
Merging time depends upon the size and number of mailboxes selected. If they are larger in 

size, the software will take more time and if they are smaller then it will take less time. 

9. Can I save the merged mailboxes? 

 
Yes, absolutely. See Save Merged Mailbox page of this manual for detailed instructions. 

 
10. How many different mailboxes does Stellar Merge mailbox for Outlook create a 

mailbox to? 

Stellar Merge Mailbox for Outlook creates multiple types of mailboxes to a single mailbox that 

is PST. 

11. I have saved my merged mailbox in PST mailbox. How to view and access the 

mailbox items? 

After you save the merged mailbox in PST mailbox, you can import the PST file in MS Outlook. 

See Import PST file in MS Outlook, to know how to import PST file. 

12. Can I use my Gmail and Yahoo! Mail account's password as app password? 

 

You cannot use your Gmail or Yahoo! Mail account's password as app password. It is required 

to generate and use the app password for merging your Gmail and Yahoo! Mail in Stellar 

Merge Mailbox for Outlook. 

13. Can I use the once-generated app password multiple times? 

 
The generated app password can only be used once. You are required to generate a new app 

password after every use. 

14. Is it necessary to keep Stellar Merge Mailbox for Outlook as the app name 

while generating the app password? 

No, it is not necessary. You are free to keep a name of your choice for the software. 

 

15. What are the Mail Clients that Stellar Merge Mailbox for Outlook merges into a single 

PST file? 

Stellar Merge Mailbox for Outlook allows the following Mail Clients to merge into a single PST 
file: 

 

¶ Outlook Express 

¶ Window Mail 

¶ Window Live Mail 

¶ Thunderbird 

¶ Spicebird 



¶ PocoMail 

¶ Eudora 

¶ Entourage 

¶ AppleMail 

¶ Mulberry 

¶ SeaMonkey 

¶ Netscape 

¶ ClawsMail 

¶ OperaMail 

¶ Mozillamail 

¶ Evolution 

¶ Sylpheed 

¶ Cone 

¶ Mutt 

¶ Gnu 

 

16. What are the email providers that Stellar Merge Mailbox for Outlook merges into a 

single PST file? 

Stellar Merge Mailbox for Outlook accepts the following email providerôs mailboxes to 

merge into a single PST file: 

 

¶ Microsoft 365 

¶ Gmail 

¶ Yahoo 

¶ Outlook.com 



 
 
 
 
 
 

 

 

 
Stellar Undelete Email for Outlook 

 
User Guide 11.0 



1. About Stellar Undelete Email for Outlook 

 
Stellar Undelete Email for Outlook successfully recovers accidentally deleted and lost emails, folders, 

calendars, appointments, meeting requests, contacts, tasks, task requests, journals, notes as much as 

possible which minimize the loss of corruption. 

 
It is a powerful software to recover deleted mails either from OST or PST files, created by MS outlook. 

All the message, calendar events, notes, etc. are discovered. After outlook data file is scanned, you can 

preview and save deleted items in PST, MSG, EML, PDF, HTML or RTF formats. 

 
Key Features: 

 
¶ Supported Output Formats - Provides options to save recovered files in PST, MSG, EML, 

RTF, HTML and PDF formats. 

¶ Selective Recovery - Provides options to save only selected emails as per requirement. 

¶ Encrypted Files Support - Supports the recovery of encrypted outlook data files (OST or 

PST). 

¶ Auto split PST file - Option to auto split new PST file at approximately 45 GB in size. 

¶ Apply Advance Filter - Option to filter specific and particular mailboxes from recovered file. 

¶ Find Option - Provides an option to find emails faster. 

¶ Resume Function - Provides an option to resume the process at a later stage by saving a 

scan information file. 

¶ Preview Before Saving - Provides a preview of recovered mail items in a three-pane 

structure. 

¶ Quick Save Option - Provides an option to right-click on emails listed in the preview section 

to save them in MSG, EML, RTF, HTML and PDF formats. 

¶ Source OST File Support - Supports MS Outlook 2021, 2019, 2016, 2013, 2010 and 2007 

OST files. 

¶ MS Outlook Support - Supports MS Office 365, 2021, 2019, 2016, 2013, 2010 and 2007. 

 
¶ Operating System - Compatible with Windows 11, Windows 10, Windows 8.1, Windows 8 

and Windows 7 (x64 edition only). 



2. User Interface 

Stellar Undelete Email for Outlook has a simple and easy to use Graphical User Interface (GUI). The 

GUI of Stellar Undelete Email for Outlook resembles the GUI of MS Office 2016. 

 
After launching the software, the main user interface appears as shown below: 

 

 
The user interface contains Ribbons and buttons that allow you to access various features of the 

software with ease. 



2.1. Ribbons and Buttons 

 
1. File Ribbon 

 

¶ Select Outlook Data File: Use this option to select for outlook data file (OST or PST). 

¶ Save Deleted Items: Use this option to save the recovered mails at your specified location. 

¶ Exit: Use this option to close the software. 

 
2. Home Ribbon 

 

¶ Select Outlook Data File: Use this option to select for outlook data file (OST or PST). 

¶ Save Deleted Items: Use this option to save the recovered mails at your specified location. 

¶ Find Message: Use this option to search for specific emails and messages from the list of the 

scanned emails. 

¶ Save Scan: Use this option to save the scanned information of the file. 

¶ Load Scan: Use this option to load the saved scan file. 

 
3. View Ribbon 

 

¶ Switch Reading Pane: Use this option to switch between horizontal and vertical views of the 

reading pane. 

¶ Log Report: Use this option to view the log report. 



4. Tools Ribbon 
 

¶ Update Wizard: Use this option to update the software. 
 

 

 

5. Calendar Ribbon 
 

¶ Day: Use this option to list all the entries of a particular day from the list of the scanned emails. 

¶ Work Week: Use this option to list all the entries of a workweek. 

¶ Week: Use this option to list all the entries of a week. 

¶ Month: Use this option to list all the entries for a particular month. 

¶ GoTo: Use this option to list all the entries of the current date or any particular date. 

 
6. Activation Ribbon 

 

¶ Activation: Use this option to activate the software after purchasing. 
 
 

 
7. Help Ribbon 

 

¶ Help Topics: Use this option to open the help manual of the software. 



¶ Knowledgebase: Use this option to visit the Knowledgebase articles of stellarinfo.com 

¶ Support: Use this option to visit the support page of stellarinfo.com 

¶ About: Use this option to read information about the software. 
 
 

 
8. Buy Now Ribbon 

 

¶ Buy Online: Use this option to buy Stellar Undelete Email for Outlook. 

 
 

 
9. Language Menu 

 

¶ Language: Use this option to change the language of the software. In the drop-down menu, you 

will find the following language options: English, French, German, Italian, Spanish and 

Japanese. 

 
10. Style Ribbon 

 

Style: Use this option to switch between various themes for the software, as per your choice. Stellar 

Undelete Email for Outlook offers the following themes: Office 2016 Colorful Theme and Office 

2016 White Theme. 

https://www.stellarinfo.com/support/kb/index.php/category/deleted-email-recovery
https://www.stellarinfo.com/
https://www.stellarinfo.com/support/
https://www.stellarinfo.com/
https://www.stellarinfo.com/email-repair/deleted-email/buy-now.php


2.2. Preview Tabs 

 
Stellar Undelete Email for Outlook provides options to navigate between Mails, Calendar, Contacts, 

Tasks, Notes and Journal views at the bottom of the left pane. It also allows you to reset/modify 

the Navigation Pane Options. 

 

¶ Click Mail  icon to preview all the emails saved in the selected mailbox. 
 

¶ Click Calendar icon to preview the calendar saved in the selected mailbox. It displays the 
schedule in an organized and efficient manner. 

 



Calendar window displays the schedule created in the selected mailbox. 

 

 
Click this button to list all the entries of one particular day from the calendar. 

 

 
Click this button to list all the entries of a workweek. 

 

 
Click this button to list all the entries of a week. 

 

 
Click this button to list all the entries of a particular month. 

 

 
Click this button to list all the entries of the current date, or a particular day (any single day 

except the current date). 

 
 

 

¶ Click Contacts  icon to preview all the contacts saved in the selected mailbox. 
 

¶ Click Tasks  icon to preview all the tasks saved in the selected mailbox. 



 
 

¶ Click Notes  icon to preview all the notes saved in the selected mailbox. 
 

 

¶ Click Journal icon to preview all the created journal entries saved in the selected mailbox. 



 
 

¶ Click and select Navigation Pane Options. This will open the Navigation Pane 
Options window. 

 
 

 
To modify/reset the navigation pane options: 

 

¶ Check/ uncheck the preview tab that you want to add/ remove from the list. 

¶ Click Move Up/ Move Down button to modify the order of the preview tabs. Move Up button will 

shift the desired tab upwards and Move Down button will shift the desired tab downwards in the 

list. 

¶ Click Reset to go back to the default list of preview tabs. 

¶ Click OK to save the changes 



3. Working with the Software 
 

3.1. Select and Recover Deleted Items 

 
3.2. Preview Recovered Items 

 
3.3. Find, View and Save a Single Message 

 
3.4. Save Recovered Items 

 
3.5. Save Log Report 

 
3.6. Save and Load Scan Information 

 

 
3.7. How to Apply Advance Filter 

 

 
3.8. Import PST file in MS Outlook 

 

 
3.9. Changing the Software Language 



3.1. Select and Recover Deleted Items 

Stellar Undelete Email for Outlook provides multiple options to select Outlook Data File (OST or PST) 

and recover deleted items from it. You can choose either Browse or Find options for outlook data file 

selection. This software also has a feature to recover deleted items from configured outlook profiles. 

 
Steps to select and scan outlook data file: 

 
1. Run Stellar Undelete Email for Outlook. 

 
2. List Configured Profiles dialog box is displayed when the software launches. 

 

 
3. Select List Profiles or Choose Manually option as per requirement to add Outlook Data File 

(OST or PST). 

Note: List Configured Profiles dialog box is displayed only once. After you click List 

profiles option, Stellar Undelete Email for Outlook software sync and list all your configured outlook 

profiles automatically. 

 
Tip: If you want to refresh the profile list, close the software and reopen it. 

 
4. After selecting an option, Select Outlook Data File screen appears as shown below. 



 

Note: Alternatively, you can also open Select Outlook Data File window from File menu or Home 

ribbon. 

 
5. There are two tabs available to select and scan Outlook data file: Profile List and Choose Mailbox 

Manually. 

 
1. Profile List: Use this tab when you want to recover deleted items from configured Outlook 

profile. This option syncs and lists all your configured outlook profiles automatically. 

 
a). From the list, select the required outlook profile. 

 
b). Click Scan to start the scanning process. 

 
c). After the process is completed, a Scan Complete dialog box appears with a 

message "Selected file has been scanned for deleted items". 

Note: To save recovered file, click Save Deleted Items button from Home ribbon. 

 

d). Click OK to complete the process. 
 
 

 
2. Choose Mailbox Manually: Use this tab to locate outlook data file with using Browse or Find 

options. 



 

(i) Browse: Use Browse button if you exactly know the location of the outlook data file (OST or 

PST) file on your system. 

 
a) Click Browse, locate the outlook data file and then click Open. 

 
b) Click Scan to start the scanning process. 

 
c) After the process is completed, a Scan Complete dialog box appears with a 

message "Selected file has been scanned for deleted items". 

Note: To save recovered file, click Save Deleted Items button from Home ribbon. 

 

d) Click OK. 

 
(ii) Find: Using the Find button, you can search for Outlook Data Files (OST or PST) on your 

system's drives. 



 

a) Click Find, Find Outlook Mailbox screen appears. 

 
b) Select the drive from the drop-down list you want to search for Outlook data files. 

However, you can only select one drive at a time. 

 
c) Click Find button to start the search process. 

 
Note: If you want to stop the search process, click Stop. 

 
d) After the search is finished, Find Complete dialog box appears with the number of files 

found. Click OK. 

 
e) The list of outlook data files (OST and PST) found in the selected drive is displayed in 

the Results section. Select the file you want to scan, only one file can be selected at a time. 

Note: If you want to clear the search result, click Clear List. 

 
f) Click Scan to start the scanning process. 

 
g) After the process is completed, a Scan Complete dialog box appears with a message 

"Selected file has been scanned for deleted items". 

Note: To save recovered items, click Save Deleted Items button from Home ribbon. 

 



h) Click OK. 

 
After the scanning is complete, the software provides a preview of the scanned outlook data file. 

See Preview Recovered Items, for more details. 



3.2. Preview Recovered Items 

Stellar Undelete Email for Outlook shows the preview after the Outlook Data File scanned. The 

preview of the mailbox data is available in a three-pane structure containing: Left pane, Middle pane 

and Right pane, which are explained below in detail: 

 

 
¶ The left pane provides the navigation tree, displaying the files with its mailboxes, folders and 

sub-folders. Select the desired mailbox/folder/sub-folder from this pane. 

¶ The middle pane provides a list of mailbox items, in a tabular format, of the selected 

mailbox/folder/sub-folder. The pane contains the following columns: 

o Importance icon: Signifies that the particular mail is sent with high importance. 

o Type: Shows the type of mail item it has. 

o Attachments: Shows an attachment icon if the particular mail item contains an 

attachment. 

o From: Shows the email address of the sender. 

o To: Shows the email address of the receiver. 

o Subject: Shows the email subject. 

o Date: Shows the date and time when the email was sent. 

 
Tip: You can change the order of the above-given columns as per your requirement. Click and hold on 

the column name and drag the column to the desired location to change it. 

 
¶ The right pane provides the preview of the mail item that you select from the middle pane. It 

shows the following information: 

o Subject: Shows the subject of the email. 

o From: Shows the email address of the sender. 

o To: Shows the email address of the receiver. 



o Attachments: Shows the attachments of the selected mailbox item. 

o Body: Shows the preview of the body of the selected mail item. 

 
Note: To switch between vertical and horizontal reading panes, click Switch Reading Pane icon 

in View ribbon. 

 
Additional Options: 

 
¶ Quick search: The software provides quick search options for Mails. In the middle pane below 

the table headings, type the keywords in the search bar of a particular column. The columns that 

support quick search are From, To, Subject, and Date. 

 

 
¶ Sorting columns: You can sort the mails and media items using the table headers in the middle 

pane. Click on the column heading to sort the column in ascending order. Click on the same 

heading again to change the sorting order from ascending to descending and vice versa. 

 

 
Alternatively, you can right-click on the column and arrange it accordingly, using Arrange By option. It can 

be arranged by Date, From, To, Subject, Type, Attachment, Deleted, Importance or Show in Groups 

option. 

 



3.3. Find, View and Save a Single Message 

Stellar Undelete Email for Outlook allows you to find a particular message from the scanned file. The 

software offers a Find Message feature, which helps you narrow the search using various search options. 

You can save a message directly from the search result in MSG, EML, RTF, HTML or PDF format. 

 
To find messages: 

 
1. Click on Find Message icon in Home Ribbon. Find Message dialog box opens. 

2. Specify the search criteria in Find Message dialog box. 

 

 
¶ In To field, specify all or few characters of email ids of recipients. Keywords should be 

separated by a semicolon (;). 

¶ In From field, specify all or few characters of email ids of senders. Keywords should be 

separated by a semicolon (;). 

¶ In Subject field, specify the subject that you need to search. 

¶ If you want to search for emails sent or received on a particular date, select Select Date 

Field checkbox, and select date from Date drop box. 

 
3. Click Find Now button to start the search. 

 

 
To view messages: 

 
1. After the search is complete, a list of emails that match the search criteria is displayed. 

2. Double-click on an email to open it in a new window. 



To save messages: 

 
¶ To save any message from the search result list, simply right-click on it and: 

o Select Save as MSG to save the message in MSG format. 

o Select Save as EML to save the message in EML format. 

o Select Save as RTF to save the message in RTF format. 

o Select Save as HTML to save the message in HTML format. 

o Select Save as PDF to save the message in PDF format. 



3.4. Save Recovered Items 

Stellar Undelete Email for Outlook allows you to save the recovered deleted items in PST, MSG, 

EML, RTF, HTML and PDF formats. 

 
Note: Before you start the saving process of recovered deleted items, make sure that Microsoft 

Outlook is closed. 

 
Steps to Save Recovered Deleted Items: 

 
1. Run Stellar Undelete Email for Outlook. 

2. See Select and Recover Deleted Items, to know how to select and recover deleted items. 

3. Click Save Deleted Items from Home ribbon to open a Save As window. 

4. From Save As options select any one of the formats: PST, MSG, EML, RTF, HTML or PDF and 

click Next. 

 

5. Select Destination screen appears. Click Browse to save recovered file at specified 

destination. 

 

Note: 

o Auto split PST file check box is selected by default, uncheck it if you do not want to split 

recovered Outlook Data File. This option helps to auto split new PST file at approximately 

45 GB in size. 

o Click Apply Advance Filter if you want to apply filter on the recovered file. 



For PST: 

 
¶ Click OK on the Select Destination window to start the saving process. 

¶ After successful saving completion, a Saving Complete dialog box appears. It shows the path 

and size of the recovered file. 

 

Note: To know how to import the new PST file in MS Outlook, click 'How to import PST file?'. 

 
¶ Click OK to close the window. 

 
 

 
For MSG, EML, RTF, HTML and PDF: 

 
¶ Click OK on the Select Destination window to start the saving process. 

¶ After successful saving completion, a Saving Complete dialog box appears with a 

message "Selected messages saved successfully". 

 

¶ Click on 'Open containing folder' link to view the saved messages. 



3.5. Save Log Report 

With Stellar Undelete Email for Outlook, you can save the Log Report to analyze the scanning 

process at a later stage. 

 
To save log report: 

 
1. From View ribbon, select Log Report. 

 
2. In Log Report dialog box, click Save Log. 

 

 
3. In Save As dialog box, specify the location where you want to save the log file. Click Save. 



3.6. Save and Load Scan Information 

This option allows you to save the scanned information of files using "Save Scan" option and later load the 

saved scan (DAT) file using "Load Scan" option. It saves time in restoring data as we do not need to 

scan the Outlook Mailbox file again. 

Steps to save scan information of the Outlook Data File: 

 
1. From the Home ribbon, click Save Scan button. 

 

2. Save Scan Information dialog box will open. Browse to the folder where you want to save the 

scan information and click OK. The information is saved as. DAT file format. 

3. A message box appears, click OK. 
 
 

 
Load Scan Information 

 
This option is used to start recovery procedure from a saved scan information or .DAT file. 

 
Steps to load scan information of the Outlook Data File: 

 
1. To load the scan information, click on Load Scan option from the Home ribbon. 

 



2. Load Scan dialog box will appear. This dialog displays a list of saved scan information file 

existing in the system. 

3. In case the file you need is not in the list, click Add button and select the needed .DAT file. 

4. Click Open. 

5. The file you added is displayed in the load scan dialog box. Click Remove button if you want to 

remove the save scan (.DAT) file. 

6. Click Reset button to reset the load scanned list. 

7. Click Load Scan button. 

8. A message box appears, click OK. 

 
Note: You can select only one file at a time to start the process of scanning. 



3.7. How to Apply Advance Filter 

Stellar Undelete Email for Outlook provides an advanced filtering feature to find specific and 

particular mails using Date Range filter. You can also narrow your search results by excluding specific 

sendersô IDs from the recovered mailbox. 

 
Steps to apply advanced filter: 

 
1. In Apply Filter window, under Include section there are two check boxes: 

 

a) Include 'Junk Email' folder: Select this check box to include junk email files and folders. 

b) Include 'Delete Items' folder: Select this check box to include deleted items file and 

folder. 

 
2. From Date Range section select the specific Start Date and End Date to find the specific mails. 

3. From Sender IDs to be excluded section enter the list of specific sendersô ID's that you don't 

want to include. 

a. In Add to List text field enter specific sender ID's that you don't want to include. 

 
Note: You can include only one sender ID at a time in Add to List text field. 

 
b. Then click Add to List button to list it. 



c. All the check boxes are selected by default, deselect the unrequired check boxes. 

 
4. Click Apply button to apply the filters. 



3.8. Import PST file in MS Outlook 

To import PST file in Microsoft Outlook 2021 / 2019 / 2016 / 2013: 

 
1. Open Microsoft Outlook. From File Menu, select Open & Export. 

2. Select Import / Export option from the right pane. 

3. From Import and Export Wizard window, select Import from another program or file, click Next. 

4. In Import a File dialog box, select Outlook Data File (.pst), click Next. 

5. Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

6. In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

 
 

 
To import PST file in Microsoft Outlook 2010: 

 
1. Open Microsoft Outlook. From File Menu, select Open -> Import. (For MS Outlook 2013, select 

Open and Import from File Menu) 

2. From Import and Export Wizard window, select Import from another program or file, click Next. 

3. In Import a File dialog box, select Outlook Data File (.pst), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

5. In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

 
 

 
To import PST file in Microsoft Outlook 2007: 

 
1. Open Microsoft Outlook. From File menu, select Import and Export. 

2. From Import and Export Wizard window, select Import from another program or file, click Next. 

3. In Import a File dialog box, select Personal Folder File (PST), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

5. In Import Personal Folders dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 



3.9. Changing the Software Language 

To use Stellar Undelete Email for Outlook in your preferred language, the software provides an 

option to select any of the desired languages. Using the Languages button, you can change the 

entire software to a different language at any time/instance without having to re-install the software. 

Steps to change the language: 

 
1. Run Stellar Undelete Email for Outlook. 

2. Click Language button located at the top right corner. 

3. A dropdown list appears with the following languages: 

 
¶ English 

¶ French 

¶ German 

¶ Italian 

¶ Spanish 

¶ Japanese 

 
4. Select the desired language. The software language will be changed accordingly. 



4. Frequently Asked Questions (FAQs) 

 
1. What is Stellar Undelete Email for Outlook used for? 

 
Stellar Undelete Email for Outlook software is used to recover mails that are knowingly or 

accidentally deleted from Outlook Mailbox. 

 
2. Does the software recover deleted e-mails in password protected/secured files? 

 
Yes, the software recovers deleted mails even in the password protected files. 

 
3. Should MS Outlook be installed on the system before executing the recovery process? 

 
Yes, MS Outlook should be installed before executing the recovery process. 

 
4. Can the software recover deleted Calendars/Contacts/Tasks/Journals/Notes folders in the e- 

mail? 

 
Yes, the software recovers these items efficiently. 

 
5. How do I select Outlook Data File (OST or PST) from my system if location is unknown? 

 
Stellar Undelete Email for Outlook can help you find Outlook Data File (OST or PST) on your system. 

There is a dedicated Find option in the software through which you can locate a particular OST or PST file 

and recover it. 

 
6. Can I recover a corrupt Outlook Mailbox file of size more than 2 GB? 

 
Absolutely yes, this tool is capable of recovering Outlook Mailbox file that is more than 2 GB. Please 

download the demo version and scan your Outlook Mailbox file. You can preview all emails and other 

mailbox items which can be recovered through this tool. 

 
7. Can the software recover the deleted attachments from the mailbox? 

 
Yes, the software recovers the deleted attachments from the mailbox. 

 

8. Does the software recovers Deleted mails from both OST and PST files? 

 
Yes, the software recovers the deleted mails from both OST and PST files. 

 
9. I have forgotten the path of my Outlook Mailbox file. Can this application search it for me? 

 
Yes, the application can look for Outlook Mailbox file on your system and find it for you easily. There is 

a dedicated Find option in the application through which you can locate a particular Outlook Mailbox 

file and run recover on it. 

10. I want to analyze the recovery process. Can I see the log report at a later stage? 



Certainly. The application gives you an option to save and view log reports at any point of time. To view 

and save log reports just follow the following steps: 

 
¶ On View ribbon, select view 'Log Report'. 

¶ In log report dialog box, click 'Save Log' and save it at a desired location for viewing it anytime. 

 
11. I have an Outlook Mailbox file exceeding 50 GB in size, does the new PST file generated will 

have same size as that of source Outlook Mailbox file? 

 
For large files, Stellar Undelete Email for Outlook automatically splits the new PST file in small sizes. 

The size of the split files will depend on the version of Outlook installed on your computer: 

 
If you have Outlook 2007 installed, the new PST will be split at approximately 18 GB size. 

 
If you have Outlook 2010 or above installed, the new PST will be split at approximately 45 GB to 48 GB 

in size. 

 
12. After saving my recovered mailbox in PST format. How to view and access the mailbox 

items? 

 
After you have saved the recovered mailbox in PST format, you can import the PST file into MS 

Outlook. See Importing PST file in MS Outlook, to know how to import the PST file. 



 
 
 
 
 
 
 
 
 
 

 

 

Stellar Splitter for Outlook 

 
User Guide 9.0 



1. About Stellar Splitter for Outlook 

 
Stellar Splitter for Outlook is a very powerful and robust software that helps you split large PST 

files into smaller files as per the criteria specified by you. 

 
Microsoft Outlook data is stored in the personal folders file that ends with the PST extension. All 

the data stored in various Outlook folders g o e s  i n  to the PST file. Outlook PST file, also known 

as Outlook Data File contains all items like emails, calendars, to-do lists, tasks, journals, notes, 

contacts. Protecting this data is crucial since it contains confidential, personal and financial 

information. 

 
Key Features: 

 
¶ Splits PST files on the basis of: 

 
o Date 

o Size 

o Mail ID 

o Folders 

¶ Allows to split single or multiple files in one operation. 

¶ Saves all your preferences to split files in a batch file. 

¶ You can create your own batch file to automate splitting of multiple files. 

¶ All activities of the software are recorded in a log. 

¶ Software doesn't make any changes in the original PST. 

¶ Supports MS Office 2021, 2019, 2016, 2013, 2010 and 2007. 
 
 

 
Note: Every time a split operation is performed, a new PST file is created without altering the 

contents and structure of original PST file. Thus, Stellar Splitter for Outlook never causes any 

damage to your invaluable original PST file. 



2. User Interface 

 
Stellar Splitter for Outlook software has a very easy to use Graphical User Interface. The user 

interface contains features required for splitting Outlook PST files. 

 
After launching the program, you will see the main user interface as shown below: 

 

 
The user interface contains ribbons and buttons that let you access various features of the 

software with ease. 



2.1. Ribbons and Buttons 

 
1. Home Ribbon: 

 

 
The Home ribbon contains the following buttons: 

 
¶ Home: Use this option to go to the home screen of the software. 

 
¶ Add PST: Use this option to add the PST files which you want to split. 

 
¶ Find PST: Use this option to search PST files from the system. 

 
¶ Select Batch File: Use this option to select already created batch file from the system. 

 
¶ Create Batch File: Use this option to create your own batch file to automate 

splitting of multiple files. 

 

 
2. View Ribbon: 

 

 
The View ribbon contains the following button: 

 
¶ Log Report: Use this option to view / save the log report. 

 

 
3. Tools Ribbon: 

 

 

 
The Tools ribbon contains the following button: 



¶ Update Wizard: Use this option to Update the software. 
 

 
4. Activation Ribbon: 

 

 

 
The Activation ribbon contains the following button: 

 
¶ Activation: Use this option to activate the software after purchasing. 

 

 
5. Help Ribbon: 

 

 

 
The Help ribbon contains the following buttons: 

 
¶ Help: Software is accompanied by a descriptive help document. Use this option to view 

the help manual for the software. 

¶ Knowledgebase: Frequently asked questions and other common queries are 

available as knowledgebase for your reference and to help you use the software to 

get the best outcome. Use this option to visit the Knowledgebase articles of 

stellarinfo.com 

¶ Support: In case you don't find any related content in the help document or on the 

knowledgebase page that resolves your query, use this option to view support page of 

stellarinfo.com and contact the Stellar customer support. 

¶ About: Use this option to read information about the software. 
 
 

 
6. Buy Now Ribbon: 

http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/


 
 
 

 
The Buy Now ribbon contains the following button: 

 
¶ Buy Online: Use this option to buy Stellar Toolkit for Outlook. 

 

 
7. Language Button: 

 

 

 
¶ Language: Use this option to change the language of the software. In the drop- 

down menu, you will find the following language options: English, French, 

German, Italian and Spanish. 

 
 

 
8. Style Button: 

 

 
Style: Use the upward arrow button to hide/unhide the ribbon. Stellar Splitter for Outlook, offers 

the following themes: Office 2016 Colorful Theme, Office 2016 White Theme. Use this option to 

switch between various themes for the software, as per your choice. 

https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php


3. Working with the Software 

 
3.1. Add PST Files 

 
3.2. Find PST Files 

 
3.3. Splitting Options 

 
3.3.1. Split Single PST By Date 

 
3.3.2. Split Single PST By Size 

 
3.3.3. Split Single PST By Mail ID 

 
3.3.4. Split Single PST By Selecting Folders 

 
3.3.5. Split Multiple PST Files By Date 

 
3.3.6. Split Multiple PST Files By Size 

 
3.4. Create and Manage Batch Files 

 
3.5. View and Save Log Report 

 
3.6. Changing the Software Language 



3.1. Add PST Files 

 
To start the split process, you need to add files to the Stellar Splitter for Outlook software. 

You can add a single file or multiple files to the software. 

Steps to add PST files: 

 
1. Run Stellar Splitter for Outlook. 

 
2. Click Add PST from Home ribbon. Open dialog box will appear. Browse and select 

the desired file and then click Open. 

 

 
Or, 

 
Click Drag & Drop to add PST button on the main interface. An Open dialog appears, 

choose the location from where you want to select the file. Click Open button. 

 
Or, 

 
Open Windows Explorer to Drag & Drop the desired files to the software. 



3.2. Find PST Files 

 
Stellar Splitter for Outlook allows you to find PST files in your computer's hard drive, in case you 

don't know their location. With the help of 'Find PST' option, you can find PST files in any folder, 

subfolder or an entire volume in your system. 

 

To Find a PST File: 

 
1. Run Stellar Splitter for Outlook. 

 
2. Click Find PST from Home ribbon. 

 
3. In Browse for Folder dialog box, select the drive or folder you want to search for PST 

files. Click OK. 

4. After the search is finished, a list of PST files found in the selected drive or folder is 

shown on the left side of the screen. 

 

5. Select files you wish to split from this list. 

 
6. From the middle pane of the screen, specify the criteria based on which you want to split 

your PST. 



3.3. Splitting Options 

 
Stellar Splitter for Outlook provides you different features to split your large PST file into smaller 

PSTs. Each option is described below, in detail. Every time a split operation is performed, a new 

PST file is created without altering the contents and structure of the original PST file. Thus, Stellar 

Splitter for Outlook never causes any damage to your invaluable original PST file. 

 
3.3.1. Split Single PST By Date 

3.3.2. Split Single PST By Size 

3.3.3. Split Single PST By Mail ID 

3.3.4. Split Single PST By Selecting Folders 

3.3.5. Split Multiple PST Files By Date 

3.3.6. Split Multiple PST Files By Size 



3.3.1. Split Single PST By Date 

 
To split single PST file by date, please follow the procedure as described below: 

 
1. Run Stellar Splitter for Outlook. 

 
2. Add PST File which you want to split. 

 
3. Stellar Splitter for Outlook displays a three-pane window. The PST File you added 

will be listed in the left pane. 

4. Select By Date option from 'Select Splitting Option' section in the middle pane of 

the screen. 

5. Click Browse and select the location where you want to save the PST File. Click OK. 

 
6. From 'Date Range' section in the right pane of the screen, 

 
¶ Select In last radio option if you want to split the PST file according to months. All 

e- mails that are sent and received in the specified months will be stored in the split 

PST file. 

¶ Select Between radio option if you want to split the PST file according to a specific 

time period. All e-mails from the specific time period will be stored in thesplit PST file. 

Select the start and end date from the list boxes. 

7. User can specify to create a new PST file of all mails sent or received in last 'x' number of 

months or mails sent or received in a specified date range. 

 



8. Click 'Split' to start the process. 

 
9. A Split Complete dialog box opens, displaying a message 'Splitting completed'. Click 

OK. The PST file will be saved at your specified location. 
 

Note:  Once the process is complete, you need to specify the path where a log can be saved 

for the split operation. This will help you to check the operation a c t i v i t i e s  performed 

on your PST file. 



3.3.2. Split Single PST By Size 

 
Split By Size option allows you to create small PST files of your bigger PST by specifying the 

size of each PST file. The size of split PST file can be 5GB, 10GB, 20GB, 30GB or 50GB. 

Note: In the demo version of the software, the size of the split PST file will not be more than 

250 MB. 

 
To split single PST file by size, please follow the procedure as described below: 

 
1. Run Stellar Splitter for Outlook. 

 
2. Add PST File which you want to split. 

 
3. Stellar Splitter for Outlook displays a three-pane window. The PST File you added 

will be listed in the left pane. 

4. Select By Size option from 'Select Splitting Option' section in the middle pane of the 

screen. 

 
5. Click Browse and select the location where you want to save the PST File. Click OK. 

 
6. From 'Specify Size' section in the right pane of the screen, specify size of each PST slice 

that you want to create from larger PST. Size range can be 5GB, 10GB, 20GB, 30GB or 

50GB. 

Note: For large files, Stellar Splitter for Outlook automatically splits the new PST file in small 

sizes. The size of the split files will depend on the version of Outlook installed on your 

computer: 

If you have Outlook 2007 installed, the new PST will be split at approximately 18 GB size. 

If you have Outlook 2010 or above installed, the new PST will be split at approximately 45 GB 

to 48 GB of size. 



 

 
7. Click 'Split' to start the process. 

 
8. A Split Complete dialog box opens, displaying a message 'Splitting completed'. Click 

OK. The PST file will be saved at your specified location. 
 

Note: Once the process is complete, you need to specify the path where a log can be saved 

for the split operation. This will help you to check the operation activities performed on your 

PST file. 



3.3.3. Split Single PST By Mail ID 

 
To split single PST file by mail id, please follow the procedure as described below: 

 
1. Run Stellar Splitter for Outlook. 

 
2. Add PST File which you want to split. 

 
3. Stellar Splitter for Outlook displays a three-pane window. The PST File you added 

will be listed in the left pane. 

4. Select By Mail ID option from 'Select Splitting Option' section in the middle pane of 

the screen. 

5. A Split PST dialog box appears prompting you to proceed to the splitting process. 

 
6. Click Yes to start the process of scanning the PST file. Once the scanning is complete, 

the software will display a list of all mail ids found in the file in the right pane of the 

screen. 

 

7. Select e-mail ids under Mail IDs scroll box to split the PST file according to e-mail ids. 

Alternatively, you can also use the Select All / Unselect All buttons to select / unselect 

all the email ids. 

8. Click Browse and select the location where you want to save the PST File. Click OK. 



 

 
9. Click 'Split' to start the process. 

 
10. A Split Complete dialog box opens, displaying a message 'Splitting completed'. Click 

OK. The PST file will be saved at your specified location. 
 

Note: Once the process is complete, you need to specify the path where a log can be saved 

for the split operation. This will help you to check the operation activities performed on 

your PST file. 



3.3.4. Split Single PST By Selecting Folders 

 
You can select one or more mail folders and create a new PST consisting of selected items 

only. To split single PST file by extracting selected items, please follow the procedure as 

described below. 

 

1. Run Stellar Splitter for Outlook. 

2. Add PST File which you want to split. 

3. Stellar Splitter for Outlook displays a three-pane window. The PST File you added 

will be listed in the left pane. 

4. Select Select & Split option from 'Select Splitting Option' section in the middle 

pane of the screen. 

5. A Split PST dialog box appears prompting you to proceed to the splitting process. 

6. Click Yes to start the process of scanning the PST file. Once the scanning is complete, 

the software will display a list of all folders found in the file in the right pane of the 

screen. 

 

7. From 'Select Folders' section in the right pane of the screen, select the folders that 

you want to be used as split criteria for the file. 

8. Click Browse and select the location where you want to save the PST File. Click OK. 



 
 

 
9. Click 'Split' to start the process. 

 
10. A Split Complete dialog box opens, displaying a message 'Splitting completed'. Click 

OK. The PST file will be saved at your specified location. 
 

Note: Once the process is complete, you need to specify the path where a log can be saved for the 

split operation. This will help you to check the operation activities performed on your PST file. 



3.3.5. Split Multiple PST Files By Date 

 
You can select and split multiple PST files by date to be stored in a folder. To split multiple 

PST files, please follow the procedure as described below. 

 
1. Run Stellar Splitter for Outlook. 

2. Add PST File which you want to split. 

3. Stellar Splitter for Outlook displays a three-pane window. The PST File you added 

will be listed in the left pane. 

4. Select By Date option from 'Splitting Option' section in the middle pane of the screen. 
 

 
5. 'Customize Split Options' section in the right pane of the screen displays the criteria 

to be set as Index, File Name, File Path, Start Date, End Date, Apply Upto File 

Index and Destination Path. 

6. You can specify date range and destination path for each file individually. The software 

also has an option to apply common settings to a group of files. 

7. Specify the start date of the date range by clicking on 'Start Date' column. You can 

apply the same start date to other files by selecting the index number in 'Apply Upto 

File Index' column. For example, if the same start date is to be applied upto third file 

in the list then select the value 3 in 'Apply Upto File Index' column. 



 

 
8. Specify the end date of the date range by clicking on 'End Date' column. You can apply 

the same end date to other files by selecting the index number in 'Apply Upto File Index' 

column. For example, if the same end date is to be applied upto second file in the list then 

select the value 2 in 'Apply Upto File Index' column. 

 



9. If you want to change the destination location of a file then click on the 'Destination 

Path' column and select a new destination. You can select the same destination path 

for a group of files by selecting the index number in 'Apply Upto File Index', column. 

For example, if the same destination path is to be selected for all files in the list, then 

select the value 4 in 'Apply Upto File Index' column. 

 

 
10. Click 'Split' to start the process. 

 
11. A Split Complete dialog box opens, displaying a message 'Splitting completed'. Click 

OK. The PST file will be saved at your specified location. 
 

Note: Once the process is complete, you need to specify the path where a log can be 

saved for the split operation. This will help you to check the operation activities 

performed on your PST file. 



3.3.6. Split Multiple PST Files By Size 

 
You can select and split multiple PST files by size to be stored in a folder. To split multiple 

PST files, please follow the procedure as described below. 

 
1. Run Stellar Splitter for Outlook. 

 
2. Add PST File which you want to split. 

 
3. Stellar Splitter for Outlook displays a three-pane window. The PST File you added 

will be listed in the left pane. 

4. Select By Size option from 'Splitting Option' section in the middle pane of the screen. 
 

 
5. 'Customize Split Options' section in the right pane of the screen displays the criteria 

to be set as Index, File Name, File Path, Apply Upto File Index, Split Size and 

Destination Path. 

6. You can specify size and destination path for each file individually. The software also 

has an option to apply common settings to a group of files. 

7. Specify the size of the new PST files by clicking on 'Split Size' column. You can apply 

the same size criteria to other files by selecting the index number in 'Apply Upto File 

Index' column. For example, if the same size of new PST files is to be created from 

upto third file in the list then select the value 3 in ' Apply Upto File Index' column. 



 

 
8. If you want to change the destination location of a file then click on the 'Destination 

Path' column and select a new destination. You can select the same destination path 

for a group of files by selecting the index number in 'Apply Upto File Index', column. 

For example, if the same destination path is to be selected for all files in the list, then 

select the value 4 in 'Apply Upto File Index' column. 

 



9. Click 'Split' to start the process. 

 
10. A Split Complete dialog box opens, displaying a message 'Splitting completed'. Click 

OK. The PST file will be saved at your specified location. 
 

Note: Once the process is complete, you need to specify the path where a log can be 

saved for the split operation. This will help you to check the operation activities 

performed on your PST file. 



3.4. Create and Manage Batch Files 

 
Stellar Splitter for Outlook provides you an option to create a batch file. A batch file contains all 

the information required to split PST files such as number of files selected, their location path, 

destination path of output file, start date, end date, processed status or any other detail as 

required by the process. It can be used as input file once it has been created either by user or by 

the software. It can also be used to review the number of files processed or to get information about 

selected files. 

 
A batch file is created either by the software itself before the initiation of the process or by the user 

to use the batch file as input to split the process. When a batch file is created by the software then 

it has a file extension of .DAT and user created batch file is saved with a file extension of .TXT 

 

 

To manually create a batch file for date- b a s e d  splitting 

 
Follow the steps mentioned below to create a batch file for date based split operation: 

 
1. Open Notepad.exe 

2. Create a structure as given below: 

First file source path;First file output destination path;First file start date;First file end date;Second 

file source path;Second file output destination path;Second file start date;Second file end date; 

3. Date must be in MM/DD/YYYY format. 

Example: C:\PST1\Test1.pst;E:\Split_Destination1\;03/23/2000;09/05/2009;D:\PST 

File2\Test2.pst;D:\Split Destination2\;11/02/2001;05/28/2008; 






























































